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PREFACE 
 
This manual explains how to use the RCC6512. 
 
Copyright© 2018 Horner APG, LLC, 59 South State Avenue, Indianapolis, Indiana 46201. All 
rights reserved. No part of this publication may be reproduced, transmitted, transcribed, 
stored in a retrieval system, or translated into any language or computer language, in any 
form by any means, electronic, mechanical, magnetic, optical, chemical, manual or otherwise, 
without the prior agreement and written permission of Horner APG, Inc. 
 
All software described in this document or media is also copyrighted material subject to the 
terms and conditions of the Horner Software License Agreement. 
 
Information in this document is subject to change without notice and does not represent a 
commitment on the part of Horner APG. 
 
Ethernet™ is a trademark of Xerox Corporation. 
microSD™ and CompactFlash are registered trademarks of SanDisk Corporation. 
 
 
For user manual updates, contact Technical Support:  
 
North America:   
Tel:  (+) (317) 916-4274 
Fax: (+) (317) 639-4279 
Web:    http://www.hornerautomation.com 
Email:  techsppt@heapg.com 
 
 
Europe:  
Tel:  (+) 353-21-4321-266 
Fax: (+) 353-21-4321-826 
Web:   https://www.hornerautomation.eu/ 
Email: technical.support@horner-apg.com 
  

http://www.hornerautomation.com/
mailto:techsppt@heapg.com
https://www.hornerautomation.eu/
mailto:technical.support@horner-apg.com


  MAN1133-09.1-EN_RCC6512_UM 

A u g u s t  1 6 ,  2 0 2 1        P a g e  3 | 103 
 

 

LIMITED WARRANTY AND LIMITATION OF LIABILITY 
 

Horner APG, LLC, ("HE-APG") warrants to the original purchaser that the RCC6512 (HE-XP) OCS 
module manufactured by HE-APG is free from defects in material and workmanship under 
normal use and service. The obligation of HE-APG under this warranty shall be limited to the 
repair or exchange of any part or parts which may prove defective under normal use and service 
within two (2) years from the date of manufacture or eighteen (18) months from the date of 
installation by the original purchaser whichever occurs first, such defect to be disclosed to the 
satisfaction of HE-APG after examination by HE-APG of the allegedly defective part or parts. 
THIS WARRANTY IS EXPRESSLY IN LIEU OF ALL OTHER WARRANTIES EXPRESSED OR IMPLIED 
INCLUDING THE WARRANTIES OF MERCHANTABILITY AND FITNESS FOR USE AND OF ALL 
OTHER OBLIGATIONS OR LIABILITIES AND HE-APG NEITHER ASSUMES, NOR AUTHORIZES 
ANY OTHER PERSON TO ASSUME FOR HE-APG, ANY OTHER LIABILITY IN CONNECTION WITH 
THE SALE OF THIS RCC6512 module. THIS WARRANTY SHALL NOT APPLY TO THIS RCC6512 
module OR ANY PART THEREOF WHICH HAS BEEN SUBJECT TO ACCIDENT, NEGLIGENCE, 
ALTERATION, ABUSE, OR MISUSE. HE-APG MAKES NO WARRANTY WHATSOEVER IN RESPECT 
TO ACCESSORIES OR PARTS NOT SUPPLIED BY HE-APG. THE TERM "ORIGINAL PURCHASER", 
AS USED IN THIS WARRANTY, SHALL BE DEEMED TO MEAN THAT PERSON FOR WHOM THE 
RCC6512 module IS ORIGINALLY INSTALLED. THIS WARRANTY SHALL APPLY ONLY WITHIN 
THE BOUNDARIES OF THE CONTINENTAL UNITED STATES. 
 
In no event, whether as a result of breach of contract, warranty, tort (including negligence) or 
otherwise, shall HE-APG or its suppliers be liable of any special, consequential, incidental or 
penal damages including, but not limited to, loss of profit or revenues, loss of use of the 
products or any associated equipment, damage to associated equipment, cost of capital, cost 
of substitute products, facilities, services or replacement power, down time costs, or claims of 
original purchaser's customers for such damages. 
 
To obtain warranty service, return the product to your distributor with a description of the 
problem, proof of purchase, postpaid, insured, and in a suitable package. 
 
 

ABOUT PROGRAMMING EXAMPLES 
 

Any example programs and program segments in this manual or provided on accompanying 
diskettes are included solely for illustrative purposes. Due to the many variables and 
requirements associated with any particular installation, Horner APG cannot assume 
responsibility or liability for actual use based on the examples and diagrams. It is the sole 
responsibility of the system designer utilizing the RCC6512 module to appropriately design the 
end system, to appropriately integrate the RCC6512 module and to make safety provisions for 
the end equipment as is usual and customary in industrial applications as defined in any codes 
or standards which apply. 
 
NOTE: The programming examples shown in this manual are for illustrative purposes only. 

Proper machine operation is the sole responsibility of the system integrator. 
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VISUAL MAP OF KEY CHAPTERS 
 

FIRST STEP of ANY TASK:  DATASHEET 
Each RCC6512 unit is sent with a datasheet in the box. The datasheet (MAN1134) is the first 
document to refer to for information related to RCC6512 model and other key installation 
information. To obtain updates to the datasheet, manual, and user documentation, visit a 
Horner website. 
 
North America                  http://www.hornerautomation.com  
Europe                               https://www.hornerautomation.eu/ 
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CHAPTER 1: SAFETY / COMPLIANCE 
 

1.1 Safety Warnings and Guidelines 
When found on the product, the following symbols specify:  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

a. All applicable codes and standards need to be followed in the installation of this product. 
b. For I/O wiring (discrete), use the following wire type or equivalent:  Belden 9918, 18 AWG, 

or larger.  
  

Warning:  Consult user documentation. Warning:  Electrical Shock Hazard. 

WARNING – EXPLOSION HAZARD – Do not disconnect equipment unless power has been switched off 
or the area is known to be non-hazardous 
 
WARNING: To avoid the risk of electric shock or burns, always connect the safety (or earth) ground 
before making any other connections.  
 
WARNING: To reduce the risk of fire, electrical shock, or physical injury it is strongly recommended to 
fuse the voltage measurement inputs. Be sure to locate fuses as close to the source as possible. 
 
WARNING: Replace fuse with the same type and rating to provide protection against risk of fire and 
shock hazards.   
 
WARNING: In the event of repeated failure, do not replace the fuse again as a repeated failure 
indicates a defective condition that will not clear by replacing the fuse.  
 
WARNING: EXPLOSION HAZARD—Substitution of components may impair suitability for Class I, 
Division 2. 
 
WARNING: The USB parts are for operational maintenance only. Do not leave permanently connected 
unless area is known to be non-hazardous. 
 
WARNING: EXPLOSION HAZARD—BATTERIES MUST ONLY BE CHANGED IN AN AREA KNOWN TO BE 
NON-HAZARDOUS 
 
WARNING: Battery May Explode If Mistreated. Do Not Recharge, Disassemble or Dispose Of In Fire. 
 
WARNING: Only qualified electrical personnel familiar with the construction and operation of this 
equipment and the hazards involved should install, adjust, operate, or service this equipment. Read 
and understand this manual and other applicable manuals in their entirety before proceeding. Failure 
to observe this precaution could result in severe bodily injury or loss of life. 
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Adhere to the following safety precautions whenever any type of connection is made to the 
module.  

a. Connect the green safety (earth) ground first before making any other connections.  
b. When connecting to electric circuits or pulse-initiating equipment, open their related 

breakers. Do not make connections to live power lines.    
c. Make connections to the module first; then connect to the circuit to be monitored.   
d. Route power wires in a safe manner in accordance with good practice and local codes. 
e. Wear proper personal protective equipment including safety glasses and insulated 

gloves when making connections to power circuits.  
f. Ensure hands, shoes, and floors are dry before making any connection to a power line.  
g. Make sure the unit is turned OFF before making connection to terminals. Make sure all 

circuits are de-energized before making connections.  
h. Before each use, inspect all cables for breaks or cracks in the insulation. Replace 

immediately if defective. 
 

1.2 Grounding  
Grounding is covered in various chapters within this manual.  
 

1.3 Compliance  
To check for compliance and updates, visit the Horner website. 
  
North America https://hornerautomation.com   
Europe    https://www.hornerautomation.eu/ 

https://hornerautomation.com/
https://www.hornerautomation.eu/
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CHAPTER 2: INTRODUCTION 
 

2.1 Visual Overview of RCC6512 OCS 
 

 
Figure 2.1 – Overview of the RCC6512  
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2.1.1    Where to Find Information about the RCC6512  

a) Datasheet [MAN1134]- The datasheet is the first document to refer to for key 
information related to specific RCC6512 models.  

 
1. The datasheets for all RCC6512 models are available on the Horner 

websites. 
2. Datasheets contain pin-outs and other model specific information.  

 
b) User Manual -This manual provides general information that is common to 

RCC6512 models and can be downloaded from our website to obtain user 
documentation and updates.                                                                                                               
North America  http://www.hornerautomation.com  
Europe   https://www.hornerautomation.eu/ 

 
2.1.2    Four Main Types of Information are covered in this manual 

a) Safety and Installation guidelines / instructions (Mechanical and Electrical) 
b) Descriptions of hardware features: serial ports, removable media, communication 

options, etc.  
c) Configuration and Use of the RCC6512 
d) Maintenance and Support 

 
2.1.3 Manual Index 

Major topics of interest may be found in the Index towards the end of this manual. 
 
 
 
  

http://www.hornerautomation.com/
https://www.hornerautomation.eu/
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2.2 Connectivity to the RCC6512  
The RCC6512 has excellent capabilities for connecting to a variety of devices. The diagram 
below shows some examples of devices that can be used with the RCC6512. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 2.2 – Visual Overview of Types of Devices that can be connected to RCC6512 
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2.3 Features of RCC6512    
 
The RCC6512 is a general purpose controller with specialized I/O to handle high speed 
applications. This device combines control, high-speed digital I/O, analog I/O and networking 
into a single, integrated package. Unique features of the RCC6512 include: 
 

- High performance CPU for control processing and communications. 
- Hardware high-speed I/O accelerator for handling high-speed input and outputs. 
- Advanced control capabilities including floating point. 
- Removable media for up to 32GB of storage of programs or data logging. 
- CsCAN networking port for communication with remote I/O, other controllers or PCs. 
- Rotary switches for network ID setting 
- USB controller programming port. 
- Two serial ports one RS232 the other RS485 in a single connector. 
- Four -10V to +10V analog outputs 
- Two 0V to +10V or 0mA to 20mA analog inputs 
- Twelve high-speed inputs for counting applications.  
- Ten sourcing high-speed outputs. Eight can be tied to PWM or HSC applications.  
- Cscape programming software that allows all aspects of the RCC6512 to be 

programmed and configured from one integrated application. 
- One on board Ethernet ports (10/100Mbps) for Cscape programming and application 

defined communication, with Auto MDI/MDI-X, Modbus TCP C/S, HTTP, FTP, SMTP, and 
Ethernet IP. 

- Eight high-speed counters that support totalizing, frequency counting, pulse width 
measurement, period measurement or quadrature.  Max High Speed Frequency is 
500kHz.  

- High speed disable, latch, load, clear, marker, and match options. 
- Programmable polarity 
- Programmable input threshold for zero cross, 5V, 12V and 24V signals 
- Programmable input filtering for 500kHz, 50kHz, and 5kHz 
- High speed output functions for PWM or camming 
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2.4 Required and Suggested Accessories  
 
Please visit the Horner Control Accessories website for communication, programming, and I/O 
accessories.   
 
North America      http://hornerautomation.com/product-category/home/control-accessories/ 
Europe                   http://www.horner-apg.com/en/products.aspx 
 
Visit our website to obtain user documentation, supplemental documents, certificates, and 
other documentation.  
 
North America https://hornerautomation.com   
Europe    https://www.hornerautomation.eu/ 
  

http://hornerautomation.com/product-category/home/control-accessories/
http://www.horner-apg.com/en/products.aspx
https://hornerautomation.com/
https://www.hornerautomation.eu/
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CHAPTER 3: MECHANICAL INSTALLATION 

 
NOTE: The datasheet is the first document to refer to for model-specific information related to 
the RCC6512. Visit the Horner websites to obtain datasheets, user documentation, and updates. 
 

3.1 Overview 
 
The mechanical installation greatly affects the operation, safety and appearance of the 
system.  Information is provided to mechanically install the unit such as cut-out sizes, 
mounting procedures, and other recommendations for the proper mechanical installation of 
the unit. 
 

3.2 Mounting Requirements  
 

 
 
  
  

DIN Rail Clip is located on back of the unit. 
 

NOTE: Screw holes and a spade connector for grounding are available for a mounting option.    

DIN Rail Mounting 
 
Be sure the DIN rail is in a horizontal position before installing the unit. The 
orientation shown to the right is necessary to prevent the unit from slipping off 
the DIN rail.   
 
Align the unit on the DIN rail then push the DIN rail clip to until it clicks into place. 
Check to ensure that the unit is secure on the DIN rail.  
 
Do NOT mount the unit on its side as this may cause the unit from slipping off 
the DIN rail.  
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3.3 RCC6512 Dimensions 
 
 

 
 

Figure 3.1– RCC6512 Dimensions  
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3.3.1 Temperature / Ventilation 
Ensure that the DIN Rail layout design allows for adequate ventilation and maintains the 
specified ambient temperature range. Consider the impact on the design if operating at the 
extreme ends of the ambient temperature range. For example, if it is determined that a 
cooling device is required, allow adequate space and clearances for the device in the panel 
box or on the panel door if DIN rail is mounted inside. 
 
3.3.2 Orientation 
RCC should be mounted with locking DIN tab facing down.  
 
 
3.3.3 Noise 
Consider the impact on the panel layout design and clearance requirements if noise 
suppression devices are needed. Be sure to maintain an adequate distance between the RCC 
and noisy devices such as relays, motor starters, etc. 
 
For details on output protection, especially when using contactors and solenoids see 
MAN0962.  
 
3.3.4 Shock and Vibration  
The RCC6512 has been designed to operate in typical industrial environments that may inflict 
some shock and vibration on the unit. For applications that may inflict excessive shock and 
vibration please use proper dampening techniques or relocate the RCC6512 to a location that 
minimizes shock and/or vibration. 
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CHAPTER 4:  ELECTRICAL INSTALLATION 
 
NOTE: The datasheet is the first document to refer to for model-specific information related 
to RCC6512 models such as pin-outs and other key installation information. Visit the Horner 
websites to obtain datasheets, user documentation, and updates. 
 

4.1 Grounding Definition 
 
Ground: The term ground is defined as a conductive connection between a circuit or piece of 
equipment and the earth. Grounds are fundamentally used to protect an application from harmful 
interference causing either physical damage such as by lightning or voltage transients or from 
circuit disruption often caused by radio frequency interference (RFI). Grounding is also for the 
safety of the user. 
 

4.2 Ground Specifications 
 
Ideally, a ground resistance measurement from equipment to earth ground is 0Ω. In reality, it 
typically is higher. The U.S. National Electrical Code (NEC) states the resistance to ground shall 
not exceed 25Ω. Horner APG recommends less than 15 Ω resistance from our equipment to 
ground. Resistance greater than 25Ω can cause undesirable or harmful interference to the 
device. 
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4.3 How to Test for Good Ground 
 
In order to test ground resistance, a Ground Resistance Tester must be used. A typical Ground 
Resistance Meter Kit contains a meter, two or three wire leads, and two ground rods. Instructions 
are supplied for either a two-point or three-point ground test.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

Figure 4.1 – Two-Point Ground Connection Test   
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4.4 Primary Power Port  
 
The DC power is on the same connector as the CAN connections. Power is 10-28VDC. 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 4.1 – Primary Power Port as Viewed Looking at the RCC6512 
 
 
 
 
 
 
  

Power port is 
shared with 
CAN.  
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CHAPTER 5: REGISTERS 
 

5.1 Register Definitions 
When programming the RCC6512, data is stored in memory that is segmented into different 
types. This memory in the controller is referred to as registers. Different groups of registers 
are defined as either bits or words (16 bits). Multiple registers can usually be used to handle 
larger storage requirements. For example, 16 single bit registers can be used to store a word, 
or two 16-bit registers can be used to store a 32-bit value.   
 
NOTE: The RCC6512 supports 256 retentive registers. Values such as setpoints, should be set 
via ladder programming, communications or loaded from the removable memory. 
 

Table 5.1 - Types of Registers in the RCC6512 

%AI Analog Input 
16-bit input registers used to gather analog input data such as voltages, 
temperatures, and speed settings coming from an attached device. 

%AQ Analog Output 
16-bit output registers used to send analog information such a voltages, 
levels or speed settings to an attached device. 

%I Digital Input 
Single-bit input registers. Typically, an external switch is connected to the 
registers. 

%M Non-Retentive Bit Non-retentive single-bit registers. 

%Q Digital Output 
Single-bit output registers. Typically, these bits are connected to an 
actuator, indicator light or other physical outputs. 

%R General Purpose 
Register 

2048 (256 Retentive) 

%S System Bit Single-bit bit coils predefined for system use. 
%SR System Register 16-bit registers predefined for system use. 
%T Temporary Bit Non-retentive single-bit registers. 

 

5.2 Useful %S and %SR registers  
 

Table 5.2 – Common %S Register Definitions 
Register Name Description 

%S1 FST_SCN Indicate First Scan 
%S2 NET_OK Network is OK 
%S3 T_10MS 10mS timebase 
%S4 T_100MS 100mS timebase 
%S5 T_1SEC 1 second timebase 
%S6 IO_OK I/O is OK 
%S7 ALW_ON Always ON 
%S8 ALW_OFF Always OFF 
%S9 PAUSING_SCN Pause 'n Load soon 
%S10 RESUMED_SCN Pause 'n load done 
%S11 FORCE I/O being forced 
%S12 FORCE_EN Forcing is enabled 
%S13 NET_IO_OK Network I/O is OK 
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Table 5.3 – %SR Registers – Master %SR Table Error! Bookmark not defined. 

Register 
Default I/O 

Name 
Description 

Min-Max 
Values 

Program 
(Read/Write) 

 

Display 
(Read/Write) 

 

%SR1 USER_SCR 
User Screen Number  
*Excludes RCC Units   

0 to 1023 Read/Write Read/Write 

%SR2 ALRM_SCR 
Alarm Screen Number (0=none) 
*Excludes RCC Units   

0 to 1023 Read Only Read Only 

%SR3 SYS_SCR 

System Screen Number  
1 = Main System Menu 
2= Set Network ID, Network Status, 
(%SR29) 
3= Set Network Baud (%SR30) 
4= Set Contrast (%SR32) 
5= View OCS Status 
6= View OCS Diagnostics 
7= View I/O Slots 
8= Set Function Key Mode (%SR33) 
9= Set Serial Ports (%SR34) 
10= Set Time/Date (%SR44-%SR50) 
11= Set Beeper (%SR183) 
12= Set Screen (%SR185) 
13= Removable Media 
14= View Protocols 
15= IP Address (ETN I/O Board) 
16= Fail Safe System 
17= Backup / Restore Data 
18= Enable AutoRun 
19= Enable AutoLoad 
20= Clone Unit -  
21= Touch Calibration 
24= License Details 
*Excludes RCC Units  

0 to 24 
 

Read/Write Read/Write 

%SR4 SELF_TST Self-Test Results   Read Only Read Only 
%SR4.1  Self-Test Results – BIOS Error  Read Only Read Only 
%SR4.2  Self-Test Results – Engine Error  Read Only Read Only 
%SR4.3  Self-Test Results – Ladder Error  Read Only Read Only 
%SR4.4  Self-Test Results – RAM Error  Read Only Read Only 
%SR4.5  Self-Test Results – Duplicate ID Error  Read Only Read Only 
%SR4.6  Self-Test Results – Bad ID Error  Read Only Read Only 

%SR4.7 
 Self-Test Results – I/O Configuration 

Error 
 Read Only Read Only 

%SR4.8  Self-Test Results – Bad Network Error   Read Only Read Only 
%SR4.9  Self-Test Results – Bad Logic Error  Read Only Read Only 
%SR4.10  Self-Test Results – Bad Clock Error  Read Only Read Only 
%SR4.11  Self-Test Results – DeviceNet Error  Read Only Read Only 

%SR4.12-.16 Reserved 

 
 
 
 

   

%SR5 CS_MODE 

Control Station Mode  
0= Idle 
1= Do I/O 
2= Run 
3= Online Change 
*Supported in Linux and XL+ units only  

0 to 3 
 

Read Only Read/Write 

%SR6  Average Scan Rate ms ( / 10)  Read Only Read Only 
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Table 5.3 – %SR Registers – Master %SR Table Error! Bookmark not defined. 

Register 
Default I/O 

Name 
Description 

Min-Max 
Values 

Program 
(Read/Write) 

 

Display 
(Read/Write) 

 
%SR7  Minimum Scan Rate ms ( / 10)  Read Only Read Only 
%SR8  Maximum Scan Rate ms ( / 10)  Read Only Read Only 
%SR9 TCH_PRESSURE Current Touch Pressure  0 to 3000 Read Only Read Only 

%SR10 
TCH_PRESSURE
_TSH 

Threshold Touch Pressure 0 to 3000 
 

Read/Write 
 

Read/Write 

%SR11-12  Ladder Size (32-Bit DINT)  Read Only Read Only 

%SR13-14   
User Text Screen Size (32-Bit DINT) 
*Excludes RCC Units   

 Read Only Read Only 

%SR15-16  
System Text Screen Size (32-Bit DINT) 
*Excludes RCC Units   

 Read Only Read Only 

%SR17-18  
I/O Configuration Table Size (32-Bit 
DINT) 

 Read Only Read Only 

%SR19-20  Network Config Table Size (32-Bit DINT)   Read Only Read Only 
%SR21-22  Security Data Table Size (32-Bit DINT)   Read Only Read Only 
%SR23  Ladder Code CRC  Read Only Read Only 
%SR24  User Text CRC  Read Only Read Only 
%SR25  System Text CRC  Read Only Read Only 
%SR26  I/O Configuration Table CRC  Read Only Read Only 
%SR27  Network Configuration Table CRC  Read Only Read Only 
%SR28  Security Data Table CRC  Read Only Read Only 

%SR29 
NET_ID 
 

Network ID   

Read Only Read / Write 
CsCAN Mode 1 to 253 
DeviceNet Mode 0 to 63 
CANOpen Mode 1 to 127 

%SR30  

Network Baud Rate 
0=125KB 
1= 250kB 
2= 5000KB 
3= 1MB 
4=50K 

0 to 4 
 

Read Only Read/Write 

%SR31  

Network Required  
0= Network not required 
1= Network required; 
2= Network optimized; 
3= Network required and optimized 

0 to 3 Read Only Read Only 

%SR32  
LCD Display Contrast setting 
*Excludes RCC Units  

0 to 255 Read Only Read/Write 

%SR33  

Function Key Toggle Mode  
0= Momentary 
1= Toggle 
*Excludes RCC Units    

0 to 1 
 

Read/Write 
Read/Write 

 

%SR34  

RS232 Serial Protocol Mode 
0= Firmware Update (RISM) 
1= CsCAN 
2= Generic (Ladder- Controlled) 
3= Modbus RTU 
4= Modbus ASCII 

 

 
 
 

Read Only 
 

Read Only 

%SR35-36  

Unique Serial Number /  
Hexadecimal LAN1 MAC ID  

 

 Read Only Read Only 



  MAN1133-09.1-EN_RCC6512_UM 

A u g u s t  1 6 ,  2 0 2 1        P a g e  24 | 103 
 

Table 5.3 – %SR Registers – Master %SR Table Error! Bookmark not defined. 

Register 
Default I/O 

Name 
Description 

Min-Max 
Values 

Program 
(Read/Write) 

 

Display 
(Read/Write) 

 

%SR37  Model Number  Read Only Read Only 

%SR38  Engine Version ( /100)  Read Only Read Only 
%SR39  BIOS Rev Number  ( / 100)  Read Only Read Only 
%SR40  FPGA Image Rev Number ( / 10)  Read Only Read Only 

%SR41  
Vertical Pixel Count 
*Excludes RCC Units  

 Read Only Read Only 

%SR42  
Horizontal Pixel Count 
*Excludes RCC Units  

 Read Only Read Only 

%SR43  Keypad Type 
*Excludes RCC Units  

 Read Only Read Only 

%SR44 RTC_SEC Real-Time-Clock Second 0 to 59 Read Only Read Only 
%SR45 RTC_MIN Real-Time-Clock Minute 0 to 59 Read Only Read Only 
%SR46 RTC_HOUR Real-Time-Clock Hour 0 to 23 Read Only Read Only 
%SR47 RTC_DATE Real-Time-Clock Date 1 to 31 Read Only Read Only 
%SR48 RTC_MON Real-Time-Clock Month 1 to 12 Read Only Read Only 

%SR49 RTC_YEAR Real-Time-Clock Year 
1996 to 
2095 

Read Only Read Only 

%SR50 RTC_DAY Real-Time-Clock Day (1=Sunday) 1 to 7 Read Only Read Only 
%SR51  Network Error Count  Read Only Read Only 
%SR52  Watchdog-Tripped Error Count  Read Only Read Only 
%SR53-54 Reserved     
%SR55.13  Self-Test: Battery Low or Missing  Read Only Read Only 

%SR56    LAST_KEY 

Key Currently Pressed  
No key = 0 (No key pressed since 
power-up) 
F1 = 1 
F2= 2 
F3= 3 
F4 = 4 
F5= 5 
F6= 6  
F7=7 
F8= 8 
F9= 9  
F10 = 10 
F11= 11 
F12 = 12 
Enter = 13 
+/ - = 14 
. (dot) = 15 
0 = 16 
1 = 17 
2 = 18  
3 = 19 
4 = 20 
5 = 21 
6 = 22 
7= 23 
8 = 24 
9 = 25 
System = 26 
Escape = 27 
Left = 28 

0 to 255 
 

Read Only 
 

Read Only 
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Table 5.3 – %SR Registers – Master %SR Table Error! Bookmark not defined. 

Register 
Default I/O 

Name 
Description 

Min-Max 
Values 

Program 
(Read/Write) 

 

Display 
(Read/Write) 

 
Right = 29 
Up = 30 
Down = 31 
Shift = 32 
Soft Key 1 = 34 
Soft Key 2 = 35 
Soft Key 3 = 36 
Soft Key 4 = 37 
Soft Key 5 = 38 
Soft Key 6 = 39 
Soft Key 7 = 40 
Soft Key 8 = 41 
Release = 255 (Keys pressed since 
power-up but not currently) 
*Excludes RCC Units  

%SR57  

LCD Backlight Dimmer Register 
0-100 = 0% to 100% On 
100-255 = 100% On 
*Excludes RCC Units  

0 to 255 Read/Write Read/Write 

%57.16  
Temporarily disable Screen Saver  
*Excludes RCC Units  

 Read/Write Read/Write 

%SR58 USER_LEDS User LEDs   Read/Write Read/Write 

%SR59  
Engine Build Number (Only last three 
numbers displayed)  

 
 

Read Only Read Only 

%SR60  

Build Option 
Build Test = 0 
Build Beta = 1 
Build Product = 2 

0 to 2 
 

Read Only 
 

Read Only 

%SR61 NUM_IDS Number of CsCAN Network IDs  Read Only Read Only 
%SR62-100 Reserved     

%SR101.3  
WebMI License Details – WebMI server 
status 
*XLEe, XLTe, X2, X4, & X7 only 

 Read Only Read Only 

%SR101.4  
WebMI License Details – WebMI user 
logged in status 
*XLEe, XLTe, X2, X4, & X7 only 

 Read Only Read Only 

%SR101.8-
101.16 

 
WebMI License Details – Number of 
users 
*XLEe, XLTe, X2, X4, & X7 only 

 Read Only Read Only 

%SR102-107 Reserved 
 
 

   

%SR108  
WebMI License Details – Number of 
webpages 
*XLEe, XLTe, X2, X4, & X7 only 

 Read Only Read Only 

%SR109  
WebMI License Details – Number of 
datapoints 
*XLEe, XLTe, X2, X4, & X7 only 

 Read Only Read Only 

%SR110-112  
WebMI License Details – Expiry date of 
WebMI license 
*XLEe, XLTe, X2, X4, & X7 only 

 Read Only Read Only 

%SR113-130 Reserved 
 
 
 

   

%SR131-135  OCS Model: ASCII, 10 characters   Read Only Read Only 
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Table 5.3 – %SR Registers – Master %SR Table Error! Bookmark not defined. 

Register 
Default I/O 

Name 
Description 

Min-Max 
Values 

Program 
(Read/Write) 

 

Display 
(Read/Write) 

 
%SR136  Communication Download Timeout  Read Only Read Only 
%SR137  Communication Idle Timeout  Read Only Read Only 
%SR138-148 Reserved     

%SR149-150  
Free-running 10kHz count: 1 count = 
0.1ms  (32-Bit DINT) 

 Read Only Read Only 

%SR151 Reserved     

%SR152  RS-485 Termination   Read / Write Read / Write 

%SR152.1  
MJ2 Termination Enable 
*Excludes RCC972 

 Read / Write Read / Write 

%SR152.2  

MJ3 Termination Enable  
*XL+ Only 
 
RS485 Termination Enable  
* X4 & X7 Only 

 Read / Write Read / Write 

%SR152.3*  
MJ1 Termination Enable  
*XL+, XLE, XLT, RCC2414 Only 

 Read / Write Read / Write 

%SR152.4*  

MJ1 Biasing  
*XL+ Only 
 
CAN Termination Enable  
*X4 & X7 Only 

 Read / Write Read / Write 

%SR153-163 Reserved      

%SR164  FailSafe / Clone     

%SR164.1  RS485 Port Biasing #1 (MJ1 or MJ2)  Read / Write Read / Write 
%SR164.2  RS485 Port Biasing #2 (MJ2 or MJ3)  Read / Write Read / Write 

%SR164.3 AUTO_RESTRD 
Indicates Automatic Restore Operation 
has been performed 

 Read Only Read Only 

%SR164.4 BCKUP_TAKN 
Indicates Backup of Registers has been 
taken 

 Read Only Read Only 

%SR164.5 EN_AUTO_RN 
Enable AUTORUN – Sets “Enable 
AutoRun” to “Yes” or “No” 

 Read / Write Read / Write 

%SR164.6 EN_AUTO_LD 
Enable AUTOLOAD – Sets “Enable 
AutoLoad” to “Yes” or “Not”  

 Read / Write Read / Write 

%SR164.7 STRT_BCKUP 
Start Backup trigger bit – Setting TRUE 
starts backup of all register data  

 Read / Write Read / Write 

%SR164.8 CLR_BACKUP 
Clear Backup trigger bit – Setting TRUE 
clears backup of all register data (if a 
backup was done previously)  

 Read / Write Read / Write 

%SR164.9 MAKE_CLONE 
MAKE_CLONE trigger bit = Setting 
TRUE does a Load Clone (if a media 
card is present)  

 Read / Write Read / Write 

%SR164.10 LOAD_CLONE 
LOAD_CLONE trigger bit – Setting TRUE 
does a LOAD CLONE (if a media card is 
present that contains clone files) 

 Read / Write Read / Write 

%SR164.11 MK_CLN_FL 
Make Clone Fail (This bit goes high 
when Make/Create Clone fails)  

 Read / Write Read / Write 

%SR164.12 
 

LD_CLN_FL 
Load Clone Fail (This big goes high 
when Load Clone fails)  

 Read / Write Read / Write 

%SR164.14   
Set to 1 to restore data manually, and 
this in turn sets %SR164.15 to 1.  
Set to 0 to abort restore operation. 

 Read / Write Read / Write 
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Table 5.3 – %SR Registers – Master %SR Table Error! Bookmark not defined. 

Register 
Default I/O 

Name 
Description 

Min-Max 
Values 

Program 
(Read/Write) 

 

Display 
(Read/Write) 

 
*RCC Units Only 

%SR164.15  

Set to 1 for manual restore of data.  
Set to 0 to complete the restore 
operation.   
*RCC Units Only 

 Read / Write Read / Write 

%SR165-166 Reserved     

%SR167  
Screen Update Time, Default= 5 
*X4 & X7 Only – Default = 10  

2 to 50 Read/Write Read/Write 

%SR168-170 Reserved     
%SR171  X-Coordinate Touched  Read Only Read Only 
%SR172  Y-Coordinate Touched  Read Only Read Only 
%SR173  System-Function Disable,  0 to 1 Read / Write Read / Write 
  %SR174  Removable Media Protect  Read/Write Read/Write 
%SR174.1  Request Media Card be Removed  Read / Write Read / Write 
%SR174.2  Indicates safe to remove Media  Read / Write Read / Write 
%SR175  Removable Media - Status  Read Only Read Only 

%SR176-177  
Removable Media Free Space (32-Bit 
DINT) 

 Read Only Read Only 

%SR178-179  
Removable Media Total Space (32-Bit 
DINT) 

 Read Only Read Only 

%SR180 Reserved     

%SR181 ALM_UNACK 
Bits 1-16 indicate Unacknowledged 
in Alarm Groups 1-16 

 Read Only Read Only 

%SR182 ALM_ACT 
Bits 1-16 indicate Active 
in Alarm Groups 1-16 

 Read Only Read Only 

%SR183 SYS_BEEP 
Beep on Keypress Enable  
0= Disabled 
1= Enabled 

0 to 1 Read / Write Read / Write 

%SR184 USER_BEEP 
Internal Beeper 
0=OFF 
1=ON 

0 to 1 Read/Write Read/Write 

%SR185  

Screen Saver Enabled  
0= Disabled 
1= Enabled 
NOTE: See %SR57.16  

0 to 1 Read Only Read Only 

%SR186  Screen Saver Time in minutes (delay) 5 to 1200 Read Only Read Only 
%SR187 NET_USE Network Usage (Avg) 0 to 1000 Read Only Read Only 
%SR188  Network Usage (Min) 0 to 1000 Read Only Read Only 

%SR189  
Maximum Net Usage of all units on the 
CAN network 

0 to 1000 
 

Read Only 
 

Read Only 

%SR190 NT_TX_AVG Network TX Usage % ( / 10) (Avg) 0 to 1000 Read Only Read Only 
%SR191  Network TX Usage % ( / 10) (Min)  0 to 1000 Read Only Read Only 
%SR192  Network TX Usage % ( / 10) (Max) 0 to 1000 Read Only Read Only 

EXTENDED SYSTEM REGISTERS 
%SR193 ONLINE_CHG Online Change    
%SR193.1  TRUE if 2 programs in target FLASH  Read Only Read Only 

%SR193.2  
TRUE to switch programs, FALSE when 
complete 

 Read Only Read Only 

%SR193.3  
TRUE if executing program is 
temporary test 

 Read Only Read Only 

%SR193.4  
TRUE during last scan of switched-from 
program 

 Read Only Read Only 
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Table 5.3 – %SR Registers – Master %SR Table Error! Bookmark not defined. 

Register 
Default I/O 

Name 
Description 

Min-Max 
Values 

Program 
(Read/Write) 

 

Display 
(Read/Write) 

 

%SR193.5  
TRUE during first scan of switched-to 
program 

 Read Only Read Only 

%SR193.6  
TRUE to revert to FLASH and delete all 
RAM; FALSE when complete 

 Read Only Read Only 

%SR193.9 
 
 

TRUE if error in temporary program  Read Only Read Only 

%SR194  
Battery Charge Temp Low 
*XL+ Only – Frequency in MHz 

 Read Only Read Only 

%SR195  
Battery Charge Temp High  
*XL+ Only – in degree centigrade 

 Read Only Read Only 

%SR196  

Charging State  
 
NOTE: Refer to MAN1142 for more 
details on Rechargeable Batteries  
 
0=Waiting 
1=Normal Charging 
2=Hot Charge  
3=Hot Charge  
4= Battery Hot  
5= Cold Charge  
6=Battery Cold  
7=No Battery  
8= Not Charging (after 8 hours of 
charging)  
9= CPU Hot, not charging  
10 Battery voltage <2V, not charging  
11= First 2 minutes Init Wait (Not 
Charging)  

0 to 11 
 

Read Only 
 

Read Only 

%SR197  Charging Current Max mA  Read Only Read Only 
%SR198  Battery Voltage is mV  Read Only Read Only 
%SR199 Reserved     
%SR200  InitRD Version ( /100)  Read Only Read Only 

%SR201-205  
Linux Kernel version:  ASCII, 10 
characters 

 Read Only Read Only 

%SR206-
208 

Reserved 
 

   

%SR209.3  
WebMI Server Status. Bit 3 is ON if 
server running.  

 Read Only Read Only 

%SR209.4  
WebMI User Logged in Status. Bit 4 is 
ON if 1 or more users logged in.  

 Read Only Read Only 

%SR209.9-
209.16 

 
Number of Users. Shows in upper byte 
in decimal format.  

 Read Only Read Only 

%SR210 
 

Time Zone: set in minutes + / - UTC.  
(Ex: EST is -4 hours = -240 minutes)  

 Read/Write Read/Write 

%SR211 

 

Daylight Saving: YES = 1 
Daylight Saving: NO = 0 
(If daylight saving is enabled, one hour 
will be added to the local time). 

 Read/Write Read/Write 

%SR212  UTC – Seconds  Read Only Read Only 
%SR213  UTC – Minutes  Read Only Read Only 
%SR214  UTC – Hours  Read Only Read Only 
%SR215  UTC – Date  Read Only Read Only 
%SR216  UTC – Month  Read Only Read Only 
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Table 5.3 – %SR Registers – Master %SR Table Error! Bookmark not defined. 

Register 
Default I/O 

Name 
Description 

Min-Max 
Values 

Program 
(Read/Write) 

 

Display 
(Read/Write) 

 
%SR217  UTC – Year  Read Only Read Only 

%SR218 

 
 
 
 
 

Number of Webpages, license detail 
(XLE/XLT, X2, X4, & X7 use %SR101 & 
%SR108-112 for WebMI License Details.) 

 Read Only Read Only 

%SR219  
Number of Data Points, license detail. 
(XLE/XLT, X2, X4, & X7 use %SR101 & 
%SR108-112 for WebMI License Details) 

 Read Only Read Only 

%SR220-222  

Expiration Date of WebMI License, 
license detail.  
(XLE/XLT, X2, X4, & X7 use %SR101 & 
%SR108-112 for WebMI License Details) 

 Read Only Read Only 

 
For additional information on system bits and registers, refer to the Help file in Cscape. 
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5.3 Register Map for RCC6512 I/O 
 

Table 5.4 – Register Map for RCC6512 I/O 
Fixed 

Address 
Digital/Analog I/O 
Function 

RCC6512 Model 

%I 
Digital Inputs 1-12 
Reserved 13-31 
ESCP Alarm* 32 

%Q 
Digital Outputs 1-10 
Reserved 11-24 

%AI 
Analog Inputs 1-2 
Reserved 3-12 

%AQ 
Analog Outputs 1-4 
Reserved n/a 

 
*Electronic Short Circuit Protection [ESCP]  
 
NOTE:  The ESCP bit is set high when the output current is too high, and the output driver has 
shut down for thermal protection. This typically happens when outputs are shorted, or they 
are driving loads that are higher than the output rating. 
 
 

5.4 Resource Limits  
 

Table 5.5– Resource Limits 
Resource Value 

%M Non-Retentive 
%S 13 

%SR 198 
%T 1024 
%R 2048 (256 retentive) 
%I 512 
%Q 512 
%AI 256 
%AQ 256 

 
 

  



  MAN1133-09.1-EN_RCC6512_UM 

A u g u s t  1 6 ,  2 0 2 1        P a g e  31 | 103 
 

CHAPTER 6: CSCAPE CONFIGURATION 
 

6.1 Overview 
 
RCC6512 hardware is programmed with a Windows based PC application called Cscape. This 
application can be used to program, configure, monitor, and debug all aspects of the RCC6512 
unit. Please see the on-line help provided with Cscape for additional details. 
 

6.2 Cscape Status Bar   
 
When the RCC6512 is connected to a PC using Cscape software a Status Bar appears at the 
bottom of the screen. The Cscape Status Bar can be used to determine if communications have 
been established between the RCC6512 and the Cscape program. Components of the Cscape 
Status Bar are explained below.  
 
 
 
 
 
 
 
 
 
 
 

Ready User:  HE-XExx1-CsCAN 
(Model=) 

Equal  Local :1   Target :2(R) [no 
forces] 

MOD 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Figure 6.1 – Cscape Status Bar 

Equal Indicator – indicates whether the current program in Cscape is equal to the program 
stored in the Target Controller. 
• If Equal, the program in Cscape is the same as the program stored in the Target Controller. 
• If Not Equal, the program in Cscape is not the same as the program stored in the Target 

Controller. 
• If Unknown, there may have been a change since the last time the program in Cscape was 

compared to the Target Controller.  

Communications Status - indicates the current status of the 
“pass through” Connector.    

 
• Local: xx – indicates the Network ID of the OCS to which 

the Cscape program is physically connected through its 
serial port. It can serve as a pass through device to other 
nodes on the network.   

 
• Target: yy(R) – indicates the Network ID of the device with 

which the Cscape program is exchanging data.  
Note: The Local unit and Target unit can be the same 
unit or they can be separate units. 

 
The following are status indicators: 
 
(R) – Running 
(D) - Do I/O 
(I) – Idle 
(?) – Cscape is not communicating with the remote unit.  
[no forces] – indicates 1o I/O has been forced. 

Message Line - 
The contents of 
these messages 
are context 
sensitive. The 
Message line can 
be empty.   

Current User - 
indicates who is logged 
(for security purposes). 

Controller Model - Network (Model Confirmation) 
 
• Controller Model indicates the controller model for 

which the program in Cscape is configured.     
 
• Network indicates the type of network that the 

program in Cscape expects to use (e.g., CsCAN). 
 
• (Model Confirmation) provides the following 

indications: 
 
• (Model=) – the actual Target Controller matches the 

configured Controller Model and Network. 
 
• (Model Not=) – the actual Target Controller does not 

match the configured Controller Model and Network. 
 
• (Model ?) – there may have been a change since the 

last time the Target Controller was compared to the 
configur1d Controller Model and Network. 

File Modified Indicator - indicates that 
the file in the selected window has 
been modified but has not been saved.  
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6.3 Establishing Communications  
 
The RCC6512 can communicate with Cscape using serial port communications via MJ1/MJ2 
Port, Ethernet, USB mini-B port, or CAN (CsCAN).   
 
To communicate with the RCC6512 via USB, you will need the automated driver installer 
located on the Horner APG web site.  
 
Otherwise, the drivers may be loaded from the HE-XEC Ethernet Utility / HTTP Web 
Server Demo / Communications Drivers section of the support files page on our 
website, found here:  https://hornerautomation.com/support-files . 
 
 
Next, connect a PC’s (Personal Computer running a Windows Microsoft operating system) USB 
port via USB cable to the USB mini B port on the RCC6512. 
 
 
 

 
 

Figure 6.2 – USB Programming Connector 
 
 
  

https://hornerautomation.com/support-files/#collapse_2
https://hornerautomation.com/support-files/#collapse_2
https://hornerautomation.com/support-files
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The PC will detect a new device has been plugged into the USB port. 
 

 

 
 

 
 

Figure 6.3 – Hardware Wizard Screenshots 
 

 
Now that the RCC6512 is plugged in, go to the Cscape menu Controller > Connection Wizard, 
and choose connection method.  For first time connection, connecting via USB is 
recommended.   
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If Controller USB COM Port is not present in the dropdown list, the Windows operating system 
has not yet recognized the OCS as an installed device. Be sure the installation process is 
complete and that the correct drivers are installed. The Connection Wizard must be 
completely closed and reopened to refresh the USB dropdown list.  
 
 
 

 
 

 

 
 
 
 
 
 

Figure 6.4 – Cscape Connection Wizard Screenshots 
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An alternate way to select the COM setting is to go to Cscape → Tools → Application Settings 
→ Communications and choose connection method in Add Target.  
 

 
 
 

 
Figure 6.5 – Cscape: Alternative Connection Method Screenshot  
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Figure 6.6 – Add Target Screenshot in Cscape 

 
 

NOTE: The following fields need to be filled for communication configuration if Cscape 
Connection Wizard was not used.  Table 6.1 explains the information needed in each field.  

1. Target Name 
2. Connection Medium 
3. Connected Device 
4. Connection Settings   
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Table 6.1—Communication Configuration Dialog 
Communication Configuration Dialog  

Target Name Name for connection. This is not a mandatory column to be filled, by 
default Cscape will populate ‘Default1’ in edit box. 

Connection Medium 
Com Port Select this option to communicate over serial communication with the 

device. The port number can be configured here. 
Ethernet Select this option to communicate over Ethernet. Provide the IP address 

of the device and select the mode: Built in/ ETN Ethernet mode, or HE 
XEC Ethernet mode. 

 
Select Built in/ ETN Ethernet mode if the device has on-board Ethernet 
port. 
   
NOTE: The controller should support the type of connectivity selected 
and configured for Ethernet communication. 

CAN Interface Select this option to communicate over CAN. This option requires 
additional hardware to be installed with the PC to be able to do so. Select 
the type of hardware installed from the dropdown. 

USB Select this option to communicate over USB. Now Horner devices and 
Horner USB to serial converters are recognized and can be specifically 
selected. 

Connected Device 
NOTE: This configuration is required if the controller to which Cscape is communicating is connected 
to a CsCAN network. 
Connected Device By default, this option is selected and networking feature of Cscape is 

disabled. 
Target Node ID On selecting this option, Networking feature of Cscape is enabled. CsCAN 

ID for the target controller to be provide here. 
Connection Settings (General Communication Settings) 

Maximum Baud Rate Select the baud rate for serial communication. 
Timeout Select the communication timeout. 

 
NOTE: Select a larger timeout for GPRS and installed modem 
communication configuration 
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If communication is established, the target indicator will show the mode of the controller  
Target: yy(R) as shown in the status section above in this chapter, section Cscape Status Bar. 
 

 
 

 
 
 
             
  Local ID and Target 

ID Match 
 
If the controller is not communicating, you may need to set the Target ID of the controller in 
Cscape or change the controllers ID on the unit itself. The Target ID allows directing 
communications to a particular unit when multiple units are connected via a CsCAN network. 
Units without CsCAN network ports respond to any network ID and do not require the ID to be 
configured. 
 
To check or change the ID on adjust the rotary switch to a value of 0 to 253 (0xFD hex). 
 
 
11.3.1 Communicating via MJ1 Serial Port 
 
Start by configuring Cscape to use the correct communications port. This can be done using 
the Tools → Options → Communication Port dialog in Cscape. 
 
Next, connect the PC’s serial port to the port labeled MJ1/2 on the RCC6512. 
 
If communications are successful, the target indicator should show the mode of the controller 
Target: yy(R) as shown in the status section above. 
 
If the controller is not communicating, it may be required to set the target ID of the controller 
in Cscape or on the unit. The Target ID allows directing communications to a particular unit 
when multiple units are connected via a CsCAN network. Units without CsCAN network ports 
respond to any network ID and do not require the ID to be configured. 
 
 
To change the Target ID of Cscape use the Controller → Set Target Network ID dialog.  

 

When connected directly to the controller to which Cscape 
communications are required, the Local ID and the Target 
ID should match. 
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11.3.2 Communicating via Onboard Ethernet Port  
 
From Cscape go to Controller → Hardware Configuration and do auto configuration for the 
connected controller, click on Config of Ethernet → Module Setup. 
 
11.3.3 Communicating via On Board Ethernet Port 

From the factory, the RCC OCS is set to the IP Address 192.168.254.128. To obtain 
Ethernet communications between Cscape and the RCC OCS using a single Ethernet 
cable between a PC and the RCC, or through an unmanaged Ethernet Switch, the PC 
will also need to be manually configured as follows (may require Administrator access 
on PC): 
1. Access the Network Connections in the Control Panel (Shortcut: Press the Windows 

key  and type ‘Network Connections’… select the resulting filtered link). 
2. Double-click the connection being used to directly connect to the RCC to bring up 

the Connection Status. 
3. Click Properties. 
4. Double-click Internet Protocol Version 4 (TCP/IPv4) in the list of available 

protocols. 
5. The PC may normally be set to “Obtain an IP address automatically”. Click next to 

Use the following IP address: 
6. Use the IP address 192.168.254.111 or something other than that of the RCC. 
7. The Subnet Mask (255.255.255.0) should fill in automatically once the IP address 

has been entered. 
8. The Default Gateway is not required for a direct connection. 
9. Click OK all the way back to the Network Connections dialog. 
10. Confirm the RCC is set to the default 192.168.254.128 address or something on the 

same network. 
11. In Cscape, click Tools → Application Settings → Communications → Configure . 
12. Select Ethernet, and then enter the IP address of the RCC. 
NOTE: The MTU setting defaults to the maximum 1500. It needs to match the PC’s MTU 
setting for the best results. A PC may be set to an MTU of 1300 or something other 
than the default maximum setting by a network administrator. 
13. The Port for CsCAN over Ethernet is 18501. 
14. The Mode for any controller with built-in Ethernet is Built-in/ETN Ethernet Mode. 
15. Change the Timeout value to 3000 for direct connections. Timeout values of 5000-

30000+ may be common for access over the internet or via VPN or other more 
complex networks. 

16. Click OK all the way back to the main Cscape window. It may take a moment to 
initialize the communications. 

17. Check the status bar for successful communications. 

 
 
See the next page for examples of the PC Ethernet setup and the Cscape Ethernet setup 
mentioned in the above steps. 
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To configure the Ethernet settings of the RCC using Cscape, go to Controller → Hardware 
Configuration. If not already done, select the correct connected controller, or use the Auto 
Config button to automatically recognize a controller that is already successfully connected to 
Cscape.  
 
 

 
 
Below the main controller configuration, under Network Ports, find LAN1 and click on the 
Config button to the right of the greyed-out ETN300. 
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Figure 6.7– Ethernet Configuration Dialog 
 

In the LAN1 Configuration, fill in the network setup for the RCC. In Module configuration 
dialog, go to IP Address field enter unused IP Address and configure unused registers in 
Register field & then click OK.  
 
 
Download the configuration in to Controller. Connect LAN cable to the Controller in default 
LAN Port.  

From Cscape go to Tools → Editor Options → Communication Port → Configure. Select 
Ethernet and enter IP address which is configured in the file. Select mode as RCC Series mode 
from drop down list. 
 
The controller should get connected to Cscape. If communications are successful, the target 
indicator should show the mode of the controller Target: yy(R) as shown in the status section 
above. 
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6.4 Configuration  
 
An overview of configuration: 

1. Start the configuration by selecting the Controller → Hardware Configuration menu 
item.  

2. If the RCC6512 is connected to the PC, press the Auto Config System button to 
automatically detect the Base model, I/O and any add-on communication options. 

3. If the RCC6512 is not connected, press the Config button to the right of the top of the 
unit. This allows the base CPU to be selected. 

4. Select either RCC6512 CsCAN from the type drop down box. 
5. Once the type of RCC6512 is selected, the model # drop down box will provide the 

RCC6512 model numbers from which to choose from. 
6. Once the RCC6512 CPU is selected, press OK to exit the dialog and configure the I/O that 

is present in the first slot. 
7. The Hardware Configuration dialog (Specifically the Module Setup tab) provides four (4) 

buttons to configure all of the I/O. Go through each area of I/O and configure it. Access 
the Module Setup dialog by selecting Hardware Configuration → Local I/O → Config → 
Module Setup.  

 

 
 

8. Once done configuring the I/O, OK out of configuration dialogs. 
 
Configuring the RCC6512 I/O has four main portions that are covered in this chapter: 

1. Digital in / HSC 
2. Digital out / PWM 
3. Analog in 
4. Analog out 

 
For additional information on I/O, refer to the chapters covering General I/O or High Speed I/O 
in this manual.   
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6.5 Digital / HSC Input Configuration  
The following figure illustrates the Digital / HSC Input Configuration dialog. 
 

 
 

Figure 6.8 – Digital / HSC Input Configuration Dialog 
 
The active mode group box allows the user to select if inputs are active high (Positive logic) or 
active low (Negative logic).  
 
The High-Speed Counters group box contains all of the windows that are used for configuring 
the eight (8) available high-speed counters on the RCC6512. In configuring a counter, the user 
needs to set the type and mode. 
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The type drop down includes the following options: 

- Disabled 
- Totalizer 
- Frequency Measurement 
- Pulse Width Measurement 
- Period Measurement 
- Quadrature 
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6.6 Digital / PWM Output Configuration  
 
The following figure illustrates the Digital / PWM Output Configuration dialog. 
 

 
Figure 6.9 – Digital / PWM Output Configuration Dialog 

 
 
The Q1 and Q2 group boxes allow the user to specify the operation of the multi-function outputs.  
 
The PWM State On Controller Stop group box contains items that allow the user to specify how 
the PWM outputs behave when the controller is stopped. These items can either hold their value 
or default to some value when the controller is stopped. 
 
NOTE: The PWM outputs are set to the OFF state at power-up and during program download 
and remain in that state until the unit is placed in RUN. 
 
The Output State On Controller Stop group box contains items to allow the user to specify how 
the remaining digital outputs behave when the controller is stopped. These items can either 
hold their value or default to some value when the controller is stopped. 
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6.7 Analog Input Configuration 
The following figure illustrates the Analog Input Configuration dialog. 
 

 
Figure 6.10 – Analog Input Configuration Dialog 

 
The Channel x drop down windows allow the user to specify the mode for each analog input to 
operate. The Channel x drop down windows are enabled/disabled according to which model is 
being configured.  
 
The Filter Constant provides filtering to all channels. 
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6.8 Analog Output Configuration  
 
The following figure illustrates the Analog Output Configuration dialog. 
 

 
 

Figure 6.11 – Analog Output Configuration Dialog 
 
 
The Output value on Stop group box contains items that allow the user to specify how the 
analog output channels behave when the controller is stopped. The outputs can either hold their 
value or default to a value when the controller is stopped. 
 
The Output Mode group box allows the user to select the operating modes for each of the analog 
outputs. Analog Output mode supported is -10V to 10V.   
 
The Filter Constant provides digital filtering to all channels. Valid filter values are 0-7. Refer to 
the datasheet [MAN1134] for more information on digital filtering. 
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6.9 Scaling Analog Inputs 
 
To access the Advanced Math Scaling function, select Tools → Project Toolbox. This will open 
a side bar, and then select Advanced Math → Scale. 
 

 
 

Figure 6.12 –Scaling Analog Inputs 
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Example 1 
The Cscape Scale function, found in the Advanced Math functions, allows for very easy 
conversion of the raw input value into a meaningful reading. For example, a pressure 
transducer may be specified as a 4-20mA signal to signify a 0-2000 psi pressure reading.  
With the analog channel set to the 4..20mA range, the raw analog input value, which is in INT 
format ranges from 0 to 4mA to 32000 for 20mA. Use the Scale function to obtain an Integer 
pressure reading using the 0-32000 raw input range and the sensor’s 0-2000psi output 
range. 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
Example 2: 
If readings with fractions are required, the raw Integer input value must first be translated in 
REAL, or Floating Point format. The Cscape INT-to-REAL Conversion function may be used to 
convert the raw input value from INT to REAL format in an intermediate memory location. The 
SCALE function, specified as REAL type, may be used to scale the converted raw value into a 
reading that supports digits beyond the decimal place, i.e. 475.25psi.  
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CHAPTER 7: GENERAL I/O 
 
7.1 Overview 
 
The RCC6512 is a compact unit that contains high density, very versatile I/O. Using the I/O 
properly requires wiring to the proper terminals and configuring Cscape properly. This section 
will offer some tips and suggestions to configure the I/O properly. For the register mapping of 
the I/O, refer to the Index at the end of this manual for the pages referencing register mapping.  
 
 

7.2 I/O Overview  
 

Table 7.1 – I/O and Model Overview 

 Model DC In 
DC 
Out 

HS In 
HS 
Out 

 0-10V / 0-
20mA In 

-10 to +10V Out 

HE-RCC6512 12 10 12 8 2 4 

 
 

Table 7.2 – Standard I/O Register Map 
 Registers Function 

%I1-12 Digital Inputs 

%Q1-10 Digital Outputs (When not controlled via PWM or HSC) 

%AI1-2 Voltage or Current Analog Input 

%AQ1-4 Voltage Analog Output 
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7.3 Solid-State Digital Outputs  
 
Solid-state digital outputs are generally used to activate lamps, low voltage solenoids, relays, and 
other low voltage and low current devices.   
 
NOTE: The digital outputs used on the RCC6512 are “sourcing” outputs. This means the output 
applies a positive voltage to the output pin when turned ON. When turned off, the output applies 
approximately zero volts with respect to the I/O ground. 
 

 
Figure 7.1 – Digital Output Wiring 

 
 
The digital outputs used in the RCC6512 have electronic short circuit protection and current 
limiting. While these electronic protections work in most applications, some application may 
require external fusing on these outputs. 
 
The digital outputs in the RCC6512 are typically controlled via %Q bits in the register mapping. 
Some of the outputs are designed for high-speed applications and can be used for PWM or 
frequency output applications. Please see the chapter on High Speed I/O for additional 
information. 
 
When the controller is stopped, the operation of each output is configurable. The outputs can hold 
the state they were in before the controller stopped, or they can go to a predetermined state. By 
default digital outputs turn off. For more information on stop state see the Index to find pages 
referencing Cscape settings.  
 
The digital outputs feature an output fault bit. %I32 will turn on if any of the outputs experience a 
short circuit, over-current or the output driver overheats.  
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7.4 Digital Inputs  
 
NOTE: The digital inputs on the RCC6512 are designed for low voltage DC inputs. The inputs are 
designed to support both positive and negative input modes. The mode is set by a configuration 
parameter in Cscape. All the inputs on the unit must be configured to the same mode. 
 

 
 

Figure 7.2 – Positive and Negative Inputs 
 
In positive logic mode, a positive voltage applied to the input will turn the input. The internal 
design of this mode is basically a resistor from the input to I/O ground. This mode is sometimes 
called sinking. 
 
In negative logic mode, connecting the input to the I/O ground or zero volts will turn the input 
on. The internal design of this mode is basically a resistor from the input to the positive I/O 
voltage (configurable for 24, 12, 5 or zero crossing). This mode is sometimes called sourcing. 
 
All 12 of the digital inputs may support high-speed input functional such as counting or 
frequency measurement.   
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7.5 Analog Inputs  
 
The analog inputs on the RCC6512 allow voltage measurement from a variety of devices.  
 
The analog inputs have a digital filter that can be used to filter electrical noise that may be 
unavoidable in some installations. The downside to digital filtering is the inputs will respond 
more slowly to sudden changes in the actual input.   
 
Each Analog Input may be specified separately in the Cscape configuration as having a range of 0-
10VDC, 0-20mA DC, or 4-20mA DC. For whichever range is configured, the Analog Input registers 
%AI1 - %AI2 will contain values between 0 – 32000 to match measurements in that range. Using 
this raw value, the Scaling function in Cscape, and the connected sensor’s given range, it is easy 
to get a measurement for display, alarming, datalogging, or any other purpose required. 
Alternately, the raw value may be used directly for PID loops. 

 

 
 

Figure 7.3 – Analog Input Wiring Options  
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7.6 Analog Outputs  
 
The analog outputs on RCC6512 devices provide high resolution +/-10 V outputs.  
 
When the controller is stopped, the operation of each output is configurable. The outputs can 
hold the state they were in before the controller stopped or they can go to a predetermined 
value. By default, analog outputs are set to a value of zero. For more information on Stop 
State, refer to the appropriate pages (see Index) for the configuration chapter for Cscape 
settings. 
 
Each Analog Output may be specified for a range of -10VDC to +10VDC. The Analog Output 
registers %AQ1 - %AQ4 may be used to control the output by placing a value between – 32000 
to +32000 into the register. This may be directly from a PID loop output, for example. 

 
Figure 7.4 – Analog Out Wiring Options 
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CHAPTER 8: HIGH SPEED I/O (HSC / PWM) 
 

8.1 Overview  
In addition to the compliment of simple analog and digital I/O, several of the RCC6512 I/O 
modules support High Speed Counting (HSC) I/O functions and supports Pulse Width 
Modulation (PWM) Output functions. The HSC functions include internal timing, frequency, 
totalizing, pulse width/period, and quadrature measurement. The PWM functions include 
traditional PWM (with variable rate and duty cycle). 
 
This chapter describes the operation of these high-level I/O functions. For configuration 
details of these functions, see Cscape Configuration.   
 

8.2 Glossary 
 

Table 8.1 – Glossary of High Speed I/O Terms  

Accumulator Register used to accumulate or store up a sum or count of many items or 
events.  

Clear A special function to zero out the value in a specific register. (Not used with 
Frequency or Period Measurement.) 

Disable A special function to prevent the counter from running. 

Encoder A sensor or transducer for converting rotary motion or position to a series 
of electronic pulses. 

Frequency 
Input 

The number of times an electromagnetic signal repeats an identical cycle in 
a unit of time, usually one second. 

Latch 
(strobe) 

A special function that uses a digital logic circuit to store one or more bits. A 
latch has a data input, a clock input and an output. When the clock input is 
active, data on the input is "latched" or stored and transferred to the output 
register either immediately or when the clock input goes inactive. The 
output retains its value until the clock goes active again.  

Marker  Input into the OCS that indicates a particular position. Typically, an encoder 
has a marker output that represents a specific point in the rotation. 

Polarity 
A Polarity pull-down box is associated with each function and indicates the 
manner in which the trigger happens (e.g., High level, Low Level, Falling 
Edge, Rising Edge).   

Preload 
(load) 

A special function used to trigger loading of a value into a register upon an 
event. (Not used with Frequency or Period Measurement.) 

Quadrature 

A high-speed device that expresses the phase relationship between two 
periodic quantities of the same period when the phase difference between 
them is one fourth of a period. A coupler in which the two output signals are 
90° out of phase. 

Totalizer A counter that sums the total number of cycles applied to its input. 
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8.3 High Speed Counter (HSC) Functions  
 

The RCC6512 supports eight very high speed, configurable counters. There are twelve 
dedicated inputs that can be configures to a number of different options. Each of the eight 
counters can run in one of five modes. Those modes are Totalizer, Frequency Counter, Pulse 
Width Measurement, Period Measurement, and Quadrature measurement. For some modes, 
more than one HSC input may be consumed. The measurement values are provided to ladder 
in a %AI register (see page 49). 
 
8.3.1 Frequency  
In frequency mode, the frequency of the input signal is written to the accumulator in terms of 
Hertz (cycles/second). When using frequency mode, four update selections are provided 
which specify the width of the sample window. Note that selecting a shorter sample window 
provides a quicker measurement (faster response) but lowers the frequency accuracy 
(resolution) and increases the minimum frequency measurement limit. In this mode the 
Disable and Latch special functions are allowed. Please see the HSC Glossary for a description 
of these functions. 
 
8.3.2 Totalize  
In totalize mode, the accumulator is simply incremented or decremented each time the input 
transitions in a specific direction.  
 
The totalizer supports the following modes: 
 

Internal This mode ties the input to the counter to an internal 10MHz or 
1MHz clock. The special functions can be used to accurately time 
events. 

Count Up This increments the accumulator when the input is enabled.  
NOTE: Two inputs can be assigned. Either input can cause the 
counter to increment. The second input can also be disabled. 

Count Down This decrements the accumulator when the input is enabled.  
NOTE: Two inputs can be assigned. Either input can cause the 
counter to decrement. The second input can also be disabled. 

Up/Down  
(Input 1 Up/Input 2 
Down) 

In this mode, input 1 (assigned to any of the four inputs) 
increments the counter, while input 2 (also assigned to any of the 
4 inputs) decrements the counter. 

Clk/Dir 
(Input 1 Clk, Input 2 
Dir) 

This mode uses input 1 as a clock signal to increment or decrement 
the counter and then uses input 2 to decide the direction. Input 2 
disabled increments the counter, while input 2 enabled 
decrements the counter. 

 
NOTE: The totalize mode enables the Disable, Latch, Preload, and Clear special functions. 
Please see the HSC Glossary for details. 
  



  MAN1133-09.1-EN_RCC6512_UM 

A u g u s t  1 6 ,  2 0 2 1        P a g e  58 | 103 
 

8.3.3 Pulse Width Measurement 
In pulse width measurement mode, the high-speed input can measure the width of a pulse 
stream in one of two modes and provides a continuous indication of the last sampled value. In 
this mode, the Disable and Latch special functions are allowed. Refer to the HSC Glossary for 
a description of these functions. 
 
Width High 1 μs Counts – In this sub-mode the accumulator value will contain the number of 1 μs 
counts the pulse is high. 

 
 
 
 
 
 
Width Low 1 μs Counts - In this sub-mode the accumulator value will contain the number of 1 μs 
counts the pulse is low. 
 
 
 
 
 
 

Figures 8.1-8.2 - Pulse Width Measurements, High & Low 
 

8.3.4 Period Measurement 
In period measurement mode, the high-speed input can measure the period of a pulse stream 
in one of two modes and provides a continuous indication of the last sampled value. In this mode 
the Disable and Latch special functions are allowed. Please see HSC Glossary for a description 
of these functions. 
 
Period Rising Edges 1 μs Counts – In this sub-mode the period of the input signal is reported in 
one (1) μs units. The period measurement will start on the rising edge of the input. 
 
 
 
 
 
 
 
Period Falling Edges 1 μs Counts – In this sub-mode the period of the input signal is reported in 
one (1) μs units. The period measurement will start on the falling edge of the input. 
 
 
 
 
 
 
 

Figures 8.3-8.4 – Period Measurement, Rising Edges & Falling Edges  

Width High 

Width Low 

Period from Rising Edge 

Period from Falling Edge 
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8.3.5  PWM Output Waveform 
 

 
 

 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 

Figure 8.5 – PWM Output Waveform  
 
 
 

Table 8.2 – PWM Output Waveform Table 
Rise Time 150ns Max 
Fall Time 150ns Max 
PWM Period Frequency = 1

𝑃𝑒𝑟𝑖𝑜𝑑
 

 
 

 
8.3.6 Register Match 
All counter modes support a register match function. When the accumulator value matches the 
Match 1 or Match 2 value setup in %AQ registers, a high-speed output with either turn on, turn 
off, or toggle based on settings in Cscape. 
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8.4 HSC Functions Register Map 
 
The register assignments for the high speed I/O can be moved via a setting in Cscape. The 
values shown are the DEFAULT values and may not match the same starting point as the values 
shown below. 
 

Table 8.3 HSC Functions Register Map 

Register  Description 

%AI101-102 HSC1 Accumulator 

%AI103-104 HSC1 Latched Accumulator 

%AI105-106 HSC2 Accumulator 

%AI107-108 HSC2 Latched Accumulator 

%AI109-110 HSC3 Accumulator 

%AI111-112 HSC3 Latched Accumulator 

%AI113-114 HSC4 Accumulator 

%AI115-116 HSC4 Latched Accumulator 

%AI117-118 HSC5 Accumulator 

%AI119-120 HSC5 Latched Accumulator 

%AI121-122 HSC6 Accumulator 

%AI123-124 HSC6 Latched Accumulator 

%AI125-126 HSC7 Accumulator 

%AI127-128 HSC7 Latched Accumulator 

%AI129-130 HSC8 Accumulator 

%AI131-132 HSC8 Latched Accumulator 

Register  Description 

%AQ101-102 HSC1 Preload Value 

%AQ103-104 HSC1 Match 1 Value 

%AQ105-106 HSC1 Match 2 Value 

%AQ107-108 HSC2 Preload Value 

%AQ109-110 HSC2 Match 1 Value 

%AQ111-112 HSC2 Match 2 Value 

%AQ113-114 HSC3 Preload Value 

%AQ115-116 HSC3 Match 1 Value 

%AQ117-118 HSC3 Match 2 Value 

%AQ119-120 HSC4 Preload Value 

%AQ121-122 HSC4 Match 1 Value 

%AQ123-124 HSC4 Match 2 Value 

%AQ125-126 HSC5 Preload Value 

%AQ127-128 HSC5 Match 1 Value 

%AQ129-130 HSC5 Match 2 Value 

%AQ131-132 HSC6 Preload Value 
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%AQ133-134 HSC6 Match 1 Value 

%AQ135-136 HSC6 Match 2 Value 

%AQ137-138 HSC7 Preload Value 

%AQ139-140 HSC7 Match 1 Value 

%AQ141-142 HSC7 Match 2 Value 

%AQ143-144 HSC8 Preload Value 

%AQ145-146 HSC8 Match 1 Value 

%AQ147-148 HSC8 Match 2 Value 

Register  Description 

%Q353 HSC1 Latch Trigger 

%Q354 HSC1 Preload Trigger 

%Q355 HSC1 Clear Trigger 

%Q356 HSC1 Disable Counter 

%Q357 HSC1 Direction 

%Q358 HSC1 Underflow/Overflow/HSCQ Reset (1-Reset) 

%Q359 HSC1 Preload Disable (1-Disable) 

%Q360 HSC1 Latch Disable (1-Disable) 

%Q369 HSC2 Latch Trigger 

%Q370 HSC2 Preload Trigger 

%Q371 HSC2 Clear Trigger 

%Q372 HSC2 Disable Counter 

%Q373 HSC2 Direction 

%Q374 HSC2 Underflow/Overflow/HSCQ Reset (1-Reset) 

%Q375 HSC2 Preload Disable (1-Disable) 

%Q376 HSC2 Latch Disable (1-Disable) 

%Q385 HSC3 Latch Trigger 

%Q386 HSC3 Preload Trigger 

%Q387 HSC3 Clear Trigger 

%Q388 HSC3 Disable Counter 

%Q389 HSC3 Direction 

%Q390 HSC3 Underflow/overflow/HSCQ Reset (1-Reset) 

%Q391 HSC3 Preload Disable (1-Disable) 

%Q392 HSC3 Latch Disable (1-Disable) 

%Q401 HSC4 Latch Trigger 

%Q402 HSC4 Preload Trigger 

%Q403 HSC4 Clear Trigger 

%Q404 HSC4 Disable Counter 

%Q405 HSC4 Direction 

%Q406 HSC4 Underflow/Overflow/HSCQ Reset (1-Reset) 

%Q407 HSC4 Preload Disable (1-Disable) 

%Q408 HSC4 Latch Disable (1-Disable) 
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%Q417 HSC5 Latch Trigger 

%Q418 HSC5 Preload Trigger 

%Q419 HSC5 Clear Trigger 

%Q420 HSC5 Disable Counter 

%Q421 HSC5 Direction 

%Q422 HSC5 Underflow/Overflow/HSCQ Reset (1-Reset) 

%Q423 HSC5 Preload Disable (1-Disable) 

%Q424 HSC5 Latch Disable (1-Disable) 

%Q433 HSC6 Latch Trigger 

%Q434 HSC6 Preload Trigger 

%Q435 HSC6 Clear Trigger 

%Q436 HSC6 Disable Counter 

%Q437 HSC6 Direction 

%Q438 HSC6 Underflow/Overflow/HSCQ Reset (1-Reset) 

%Q439 HSC6 Preload Disable (1-Disable) 

%Q440 HSC6 Latch Disable (1-Disable) 

%Q449 HSC7 Latch Trigger 

%Q450 HSC7 Preload Trigger 

%Q451 HSC7 Clear Trigger 

%Q452 HSC7 Disable Counter 

%Q453 HSC7 Direction 

%Q454 HSC7 Underflow/Overflow/HSCQ Reset (1-Reset) 

%Q455 HSC7 Preload Disable (1-Disable) 

%Q456 HSC7 Latch Disable (1-Disable) 

%Q465 HSC8 Latch Trigger 

%Q466 HSC8 Preload Trigger 

%Q467 HSC8 Clear Trigger 

%Q468 HSC8 Disable Counter 

%Q469 HSC8 Direction 

%Q470 HSC8 Underflow/Overflow/HSCQ Reset (1-Reset) 

%Q471 HSC8 Preload Disable (1-Disable) 

%Q472 HSC8 Latch Disable (1-Disable) 

Register  Description 

%I417 HSC1 Overflow Flag 

%I418 HSC1 Underflow Flag 

%I419 HSC1 HSCQ 

%I420 HSC1 Reserved 

%I421 HSC2 Overflow Flag 

%I422 HSC2 Underflow Flag 

%I423 HSC2 HSCQ 

%I424 HSC2 Reserved 
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%I425 HSC3 Overflow Flag 

%I426 HSC3 Underflow Flag 

%I427 HSC3 HSCQ 

%I428 HSC3 Reserved 

%I429 HSC4 Overflow Flag 

%I430 HSC4 Underflow Flag 

%I431 HSC4 HSCQ 

%I432 HSC4 Reserved 

%I433 HSC5 Overflow Flag 

%I434 HSC5 Underflow Flag 

%I435 HSC5 HSCQ 

%I436 HSC5 Reserved 

%I437 HSC6 Overflow Flag 

%I438 HSC6 Underflow Flag 

%I439 HSC6 HSCQ 

%I440 HSC6 Reserved 

%I441 HSC7 Overflow Flag 

%I442 HSC7 Underflow Flag 

%I443 HSC7 HSCQ 

%I444 HSC7 Reserved 

%I445 HSC8 Overflow Flag 

%I446 HSC8 Underflow Flag 

%I447 HSC8 HSCQ 

%I448 HSC8 Reserved 
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8.5 High Speed Output Functions 
 
Eight of the ten outputs can be configured for one of three modes of operation. Those modes are 
Normal, PWM and HSC Match.   
 
8.5.1 Normal 
When either Q1 to Q8 is configured for Normal operation, the digital output registers %Q1 to %Q8 
drives that respective output. 
 
 
8.5.2 PWM 
When either Q1 to Q8 is configured for PWM, the PWM function drives that respective output. 
Both PWM channels may be individually enabled and can have independent frequency and duty 
cycles. 
 
The PWMs require two parameters (%AQs) to be set for operation. These parameters may be set 
at run-time.   

 
Duty Cycle - The Duty Cycle is a 32-bit value from 0 to 32,000 indicating the relative duty 
cycle of the output. For example, a value of 8000 would indicate a 25% duty cycle, a value of 
16,000 would indicate a 50% duty cycle. The value 0 turns the output off, and 32,000 turns 
the output on.  

 
Frequency - The Frequency is a 32-bit value indicating the output frequency in Hertz. One 
over the frequency is the period. 

 

 
Figures 8.6 & 8.7 – PWM, Two Parameters: Duty Cycle and Frequency 

  

Duty Cycle 

Period 
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At controller power-up or during a download, the PWM output is maintained at zero until both the 
Frequency and the Duty cycle are loaded with non-zero values. When the controller is placed in 
stop mode, the state of the PWM outputs is dependent on the PWM State on Controller Stop 
configuration. This configuration allows for either hold-last-state or specific frequency and duty 
cycle counts. Specifying zero for either the period or duty causes the PWM output to remain low 
during stop mode. 
 
 
8.5.3 High Speed Counter Match 
When either Q1 to Q8 is configured for HSC Output operation, their output state is based on a 
comparison between the counter accumulator and match registers. See details above in the 
high-speed input section. 
 

8.6 High Speed Output Functions Register Map 
The register assignments for the high speed I/O can be moved via a setting in Cscape. The 
values shown are the DEFAULT values and may not match the same starting point as the values 
shown below. 
 
 

Table 8.4  
PWM I/O Register Map 

Register Description 

%AQ151 – 152 PWM1 Duty Cycle  

%AQ153 – 154 PWM1 Frequency  

%AQ155 – 156 PWM2 Duty Cycle  

%AQ157 – 158 PWM2 Frequency  
%AQ159 – 160 PWM3 Duty Cycle  
%AQ161 – 162 PWM3 Frequency  
%AQ163 – 164 PWM4 Duty Cycle  
%AQ165 – 166 PWM4 Frequency  
%AQ167 – 168 PWM5 Duty Cycle  
%AQ169 – 170 PWM5 Frequency  
%AQ171 – 172 PWM6 Duty Cycle  
%AQ173 – 174 PWM6 Frequency  
%AQ175 – 176 PWM7 Duty Cycle  
%AQ177 – 178 PWM7 Frequency  
%AQ179 – 180 PWM8 Duty Cycle  
%AQ181 – 182 PWM8 Frequency  
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8.7 PWM Examples 
 

Example 1 Duty Cycle Frequency 
To get a 50% Duty Cycle @ 
10kHz waveform on PWM1: 

Set %AQ150-151 = 16,000 Set %AQ152-153 = 10,000 

 
Example 2 Duty Cycle Frequency 

To get a 50% Duty Cycle on 
PWm1 and 90 % Duty Cycle on 
PWM2 @ 1kHz waveform: 

Set %AQ150-151 = 16,000 
 

Set %AQ154-155 = 28,800 
(duty cycle (32000 * 0.9)) 

Set %AQ152-153 = 1,000 
 

Set %AQ156-157 = 1,000 

 
Example 3 Duty Cycle Frequency 
To turn PWM 1 output ON all 
the time 

Set %AQ150-151 = 32,000 Set %AQ152-153 = Any Value 

 
Example 4 Duty Cycle Frequency 
To turn PWM 1 output OFF all 
the time 

Set %AQ150-151 = 0 Set %AQ152-153 = Any Value 
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CHAPTER 9 SERIAL COMMUNICATIONS  
 

9.1 Overview 
 
RCC6512 models provide two independent serial ports on a single 8-pin modular RJ45 
connectors, which is labeled MJ1/MJ2. RS-232 is available on MJ1, and RS-485 is available on 
MJ2. By default, MJ1 can be connected to the COM port of a PC running Cscape, for OCS 
programming. In addition, MJ1 and MJ2 can be used for application-specific communication, 
using a variety of standard data exchange protocols. 
 
 

9.2 Port Descriptions 
 
Two serial ports are provided via the single 8-position modular jack labeled “MJ1/2”. MJ1 defaults 
to one of several methods available to program the controller. It may instead be specified for RS-
232 communications, such as for Modbus Master/Slave, or to communicate to devices such as bar 
code scanners. 
 

MJ2 may only be used as a half-duplex (2-wire) RS-485. The most common use is for Modbus 
communications, either as a Modbus Master or Modbus Slave, though other options are also 
available. 
 

9.3 Serial Port Pinouts 
 

 
Figure 9.1 – Serial Port Pinouts   
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9.4 RS485 Termination and Biasing 
 
Proper RS485 termination minimizes signal reflections and improves reliability. 
 
MJ2 serial port allows an internal termination resistor to be placed across pins 1 and 2 by 
software control. 
 
Only the two devices physically located at the endpoints of the RS485 network should be 
terminated. 
 
RS485 biasing passively asserts a line-idle state when no device is actively transmitting, which 
is useful for multi-drop RS485 networking. 
 
MJ2 serial port allows internal bias resistor to be activated by software control, pulling pin 1 
up to 3.3V and pulling pin 2 down to ground. 
If biasing is used, it should be enabled in only one of the devices attached to the RS485 
network. 
 
Below are the details: 
 
• For MJ2 termination make high %SR152.1 
• For MJ2 biasing make high %SR164.1 
 
 

9.5 Cscape Programming via Serial Port   
 
The RCC6512 MJ1 serial port supports CsCAN Programming Protocol. If a PC COM port is 
connected to the RCC6512 MJ1 port, Cscape can access the RCC6512 for programming and 
monitoring. Programming can also be done via the CAN port, USB mini-B port, or Ethernet. 
 
 

9.6 Ladder-Controlled Serial Communication  
 
Using Serial Communication function blocks, MJ1 and MJ2 serial ports support Generic 
Modbus Master and Modbus Slave Protocols. In addition, external modems can be connected 
and accessed using Modem function blocks. 
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CHAPTER 10: CAN COMMUNICATIONS 
 
NOTE: For additional CAN information, refer to the CAN Networks manual (MAN0799) on the 
Horner websites.   
 

10.1 Overview 
 
All RCC6512 models provide one CAN network port, which is implemented with a 5-pin 
connector.   

 

 
Figure 9.1 – CAN Connector Location 

 
The CAN port allows the RCC6512 to exchange global data with other OCS/RCS controllers 
and to access remote Network I/O devices (SmartStix, Smart Blocks and Smart Rail Modules). 
The CAN port also supports pass-through communications for programming multiple OCS 
controllers over the CsCAN network. 
 
 

10.2 Port Description   
 
The RCC6512 CAN ports implement the ISO 11898-2 physical layer and the CAN 2.0A data link 
layer standards.   
 
The CAN port is provided via two connection: CH and CL. Power for the unit is provided 
through CAN port as well through V+ and V-.  The CAN port may be used to communicate with 
other OCS products using Horner’s CsCAN protocol. 
  

 

CAN / PWR 
Connector 
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10.3 Setting ID Switches 
 
CsCAN Network IDs are set using the hexadecimal number system from 01 to FD. The 
decimal equivalent is 1-253. Refer to the following Conversion Table, which shows the 
decimal equivalent of hexadecimal numbers. Set a unique Network ID by inserting a small 
Phillips screwdriver into the two identical switches. 
 
NOTE: The CsCAN Baud Rate for SmartBlock I/O is fixed at 125kBd. 
 

 
 

Dec      Hex  Dec      Hex  Dec      Hex  Dec      Hex  Dec      Hex  Dec      Hex  Dec      Hex  Dec      Hex  Dec      Hex  
 HI  LO  HI  LO  HI  LO  HI  LO  HI  LO  HI  LO  HI  LO  HI  LO  HI  LO 

1 0 1 29 1 D 57 3 9 86 5 6 114 7 2 142 8 E 170 A A 198 C 6 226 E 2 

2 0 2 30 1 E 58 3 A 87 5 7 115 7 2 143 8 F 171 A B 199 C 7 227 E 3 

3 0 3 31 1 F 59 3 B 88 5 8 116 7 4 144 9 0 172 A C 200 C 8 228 E 4 

4 0 4 32 2 0 60 3 C 89 5 9 117 7 5 145 9 1 173 A D 201 C 9 229 E 5 

5 0 5 33 2 1 61 3 D 90 5 A 118 7 6 146 9 2 174 A E 202 C A 230 E 6 

6 0 6 34 2 2 62 3 E 91 5 B 119 7 7 147 9 3 175 A F 203 C B 231 E 7 

7 0 7 35 2 3 63 3 F 92 5 C 120 7 8 148 9 4 176 B 0 204 C C 232 E 8 

8 0 8 36 2 4 64 4 0 93 5 D 121 7 9 149 9 5 177 B 1 205 C D 233 E 9 

9 0 9 37 2 5 65 4 1 94 5 E 122 7 A 150 9 6 178 B 2 206 C E 234 E A 

10 0 A 38 2 6 66 4 2 95 5 F 123 7 B 151 9 7 179 B 3 207 C F 235 E B 

11 0 B 39 2 7 67 4 3 96 6 0 124 7 C 152 9 8 180 B 4 208 D 0 236 E C 

12 0 C 40 2 8 68 4 4 97 6 1 125 7 D 153 9 9 181 B 5 209 D 1 237 E D 

13 0 D 41 2 9 69 4 5 98 6 2 126 7 E 154 9 A 182 B 6 210 D 2 238 E E 

14 0 E 42 2 A 70 4 6 99 6 3 127 7 F 155 9 B 183 B 7 211 D 3 239 E F 

15 0 F 43 2 B 72 4 8 100 6 4 128 8 0 156 9 C 184 B 8 212 D 4 240 F 0 

16 1 0 44 2 C 73 4 9 101 6 5 129 8 1 157 9 D 185 B 9 213 D 5 241 F 1 

17 1 1 45 2 D 74 4 A 102 6 6 130 8 2 158 9 E 186 B A 214 D 6 242 F 2 

18 1 2 46 2 E 75 4 B 103 6 7 131 8 3 159 9 F 187 B B 215 D 7 243 F 3 

19 1 3 47 2 F 76 4 C 104 6 8 132 8 4 160 A 0 188 B C 216 D 8 244 F 4 

20 1 4 48 3 0 77 4 D 105 6 9 133 8 5 161 A 1 189 B D 217 D 9 245 F 5 

21 1 5 49 3 1 78 4 E 106 6 A 134 8 6 162 A 2 190 B E 218 D A 246 F 6 

22 1 6 50 3 2 79 4 F 107 6 B 135 8 7 163 A 3 191 B F 219 D B 247 F 7 

23 1 7 51 3 3 80 5 0 108 6 C 136 8 8 164 A 4 192 C 0 220 D C 248 F 8 

24 1 8 52 3 4 81 5 1 109 6 D 137 8 9 165 A 5 193 C 1 221 D D 249 F 9 

25 1 9 53 3 5 82 5 2 110 6 E 138 8 A 166 A 6 194 C 2 222 D E 250 F A 

26 1 A 54 3 6 83 5 3 111 6 F 139 8 B 167 A 7 195 C 3 223 D F 251 F B 

27 1 B 55 3 7 84 5 4 112 7 0 140 8 C 168 A 8 196 C 4 224 E 0 252 F C 

28 1 C 56 3 8 85 5 5 113 7 1 141 8 D 169 A 9 197 C 5 225 E 1 253 F D 
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10.4 CAN and Power Port Wiring  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

Figure 10.2 – CAN Port Pins 
 

10.5 Cscape Programming via CAN 
 
The CAN port supports CsCAN Programming Protocol. If a PC has a CAN interface installed (via 
PCI card or USB), and the PC CAN port is connected to the RCC6512 CAN1 port, Cscape can 
access the RCC6512 for programming and monitoring. 
 
In addition, the RCC6512 supports single-point-programming of all RCC6512 and other OCS/RCS 
devices that are connected to the CAN1 port network. If the PC COM port is connected to the 
RCC6512 MJ1 serial port, the RCC6512 can act as a pass-through gateway allowing Cscape to 
access all RCC6512 and OCS/RCS devices that are attached to the CAN1 port network. 
 

10.6 Ladder-Controlled CAN Communication  
 
Using Put and Get Network Words function blocks, the CAN port can exchange digital and analog 
global data with other RCC6512 or OCS/RCS devices (nodes) attached to the CAN1 port network.  
 
In addition, Put and Get Network Heartbeat function blocks allow nodes on the CAN port 
network to regularly announce their presence and to detect the presence (or absence) of other 
nodes on the network. 
 
 

CAN1 & CAN2 Port Pins 

Pin Signal Signal Description 

1 V- CAN and Device Ground – Black  

2 CN_L CAN Data Low - Blue 

3 SHLD Shield Ground - None 

4 CN_H CAN Data High - White 

5 V+ 
Positive DC Voltage 

Input (10 – 28VDC) - Red 

CAN Connector 
 

Use the CAN Connector 
when using CsCAN or 

another CAN network. 
 

Torque rating 4.5 – 7 in-lbs 
(0.50 – 0.78 N-m). 

 



  MAN1133-09.1-EN_RCC6512_UM 

A u g u s t  1 6 ,  2 0 2 1        P a g e  73 | 103 
 

CHAPTER 11: ETHERNET COMMUNICATION  
 

11.1 Ethernet Module Protocols and Features 
 
The following table describes the Ethernet Module Protocols and features supported by the 
Ethernet port on the RCC6512. 
 

Table 11.1 – Ethernet Module Protocols & Features 
Protocol / Feature Protocol / Feature Description 

ICMP (Ping) Internet Control Message Protocol 
EGD  Ethernet Global Data 
CsCAN TCP Server Horner APG CsCAN over Ethernet (for Cscape to OCS programming) 
Modbus Slave Modbus over Ethernet 
Ethernet / IP Server ODVA CIP over Ethernet 
FTP (File Server) File Transfer Protocol 

 
 

11.2 Ethernet System Requirements  
Full Ethernet functionality requires PC running Cscape Programming Software Version 9.8 SP1 
or later (for configuration). 
 
 

11.3 Ethernet Module Specifications 
 

Table 11.2 – Ethernet Module Specifications 

Speeds 
10 BaseT Ethernet (10Mbps) 
100 BaseTx Fast Ethernet (100Mbps) 

Modes Half or Full Duplex 
Auto-Negotiation Both 10/100Mbps and Half/Full Duplex 
Connector Type Shielded RJ-45 
Cable Type 
(Recommended) 

CAT5 (or better) UTP 

Port Auto MDI/MDI-X (Auto Crossover) 
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11.4 Ethernet Module Configuration 
 
NOTE: The following configuration is required for all applications regardless of the protocols 
used. Additional configuration procedures must be performed for each protocol used. 
 
To configure the Ethernet Module, use Cscape Programming Software to perform the following 
steps: 
 

1. On the main Cscape screen, select the Controller menu and its Hardware 
Configuration sub-menu to open the I/O Configuration dialog (Figure 11.1). 

2. If configuring a different OCS Model than the one shown in the Hardware 
Configuration dialog, click on the topmost Config button, select the desired OCS 
Model, and then click OK.   
 

 
 

 
       

Figure 11.1 – Hardware Configuration Dialog 
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3. Click the Config button to the right of LAN1 for LAN 1, revealing the Ethernet Module 
Configuration dialog as shown in Figure 11.2 

 

 
Figure 11.2 – Ethernet Configuration 
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Configure the Ethernet Module parameters as follows: 
 
IP Address: Enter the static IP Address for the Ethernet Module being configured. 
 

NOTE: IP Addresses are entered as four numbers, each ranging from 0 to 255. These 
four numbers are called octets, and they are always separated by decimal points. 

 
Net Mask: Enter the Net Mask (sometimes called Subnet Mask) being used by all nodes on the 
local network. Typical local networks use Class C IP Addresses, in which case the low octet 
(rightmost number) is used to uniquely identify each node on the local network. In this case, 
the default Net Mask value of 255.255.255.0 should be used. 
 
Gateway: Enter the IP Address of a Gateway Server on the local network that allows for 
communication outside of the local network. To prevent the Ethernet Module from 
communicating outside the local network, set the Default Gateway IP Address to 0.0.0.0 (the 
default setting). 
 
Status Register: Enter an OCS Register reference (such as %R100) to indicate which 16-bit OCS 
register will have the Ethernet Status Word written to it. Table 11.3 shows how this register value 
is formatted and explains the meaning of each bit in the Status Word. 
 

 
Table 11.3 – Ethernet Status Word Register Format 

 
High Byte Low Byte 

Bit 
16 

Bit 
15 

Bit 
14 

Bit 
13 

Bit 
12 

Bit 
11 

Bit 
10 

Bit 
9 

Bit 
8 

Bit 
7 

Bit 
6 

Bit 
5 

Bit 
4 

Bit 
3 

Bit 
2 

Bit 
1 

0 0 Dup Spd 0 Rx Tx Link TCP Connections 

Status Bit(s) Status Indication 
Status Values 

Minimum Maximum 
0 Reserved Always 0 

Dup Link Duplex (Auto-Negotiated) 
0 = Half 
Duplex 

1 = Full 
Duplex 

Spd Link Speed (Auto-Negotiated) 0 = 10MHz 1 = 100MHz 
Rx Receive State 0 = Inactive 1 = Active 
Tx Transmit State 0 = Inactive 1 = Active 

Link Link State 0 = Down 1 = Up 

TCP Connections 
Total Number of Active TCP 

Connections 
(CsCAN, SRTP, Modbus, EIP, FTP, HTTP) 

0 40 

 
Version Register: Enter a register reference (such as %R101) to indicate which 16-bit register 
will have the Ethernet Firmware Version written to it. The value stored in the Version Register 
is (Ethernet Firmware Version * 100). For example, for Ethernet Firmware Version 4.30, the 
Version Register will contain 430. This version will only change with a complete controller 
Firmware Update. 
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Ethernet Module Register Usage - Standard Configuration 
 
To perform a standard configuration, fill in the IP Address, Net Mask, and Gateway with 
addresses that are valid for the network to which the controller is connected. If desired, 
registers may be specified in which these settings will be reflected.  
 
NOTE: If registers are to be used to define the IP, use registers from the retentive set: %R1 - 
%R256. Assigning from the non-retentive set may be lost through a power cycle.  
 
Leave the Get settings from selection set to Configuration.  
 
Optionally, check the Use CAN ID for last Octet box in order to leave the last octet of the IP 
Address editable by way of changing the controllers CAN ID. This does not affect the Net Mask 
or Gateway settings.  
 
NOTE: The low octet of the IP Address can be replaced with the unit’s CAN Network ID, by 
checking the Use CAN ID for last Octet checkbox. 
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CHAPTER 12: REMOVABLE MEDIA 
 

12.1 Overview 
 
All RCC6512 models provide a Removable Media slot, labeled Memory Card, which supports 
standard microSD Flash memory cards. microSD cards can be used to save and load 
applications. 
 

 
Figure 12.1 – Removable microSD Memory Card Slot 

 
 

12.2 microSD Cards 
 
The Memory Card slot is equipped with a “push-in, push-out” connector and a microSD card can 
be safely inserted into the memory card slot whether the RCC6512 power is On or Off.   
 
To install a microSD card: Align its 8-pin gold edge connector down, facing the circuit board of 
the RCC6512 unit as shown in Figure 12.1; then carefully push it all the way into the Memory slot.  
Ensure that it clicks into place.    
 
To remove the microSD card: Push in on the top of the card gently to release the spring. The 
card pops out for removal. 
 
 

12.3 microSD File System  
 
The microSD Memory slot supports SDHC IN FAT32 format up to 32GB max.  The microSD slot 
can be used for program download (*.pgm), to save the downloaded program (*.pgm), for 
loading and logging data (*.csv. Long filenames are supported for program download.  
  



  MAN1133-09.1-EN_RCC6512_UM 

A u g u s t  1 6 ,  2 0 2 1        P a g e  79 | 103 
 

12.4 Using Removable Media to Load and Save Applications   
 
A special file type, with a .PGM extension, is used to store RCC6512 application programs on 
microSD. 
 
Pressing and holding the LOAD button for three seconds upon power up will load the program 
that is stored on the microSD.  Refer to the Troubleshooting chapter for more details. 
 
Cscape can also save an application directly to a microSD card, which is plugged into the PC’s 
microSD compatible card reader by selecting the Export to Removable Media item on the 
Cscape File menu. 
 
 

12.5 Removable Media (RM) Function Blocks in Cscape  
 
NOTE: For detailed information regarding RM function blocks and parameters, refer to the 
help file in Cscape Software.  
 
The following RM functional blocks are available in Cscape Software. These function blocks will 
reference microSD when filename is prefixed with ‘A:’ or nothing. 

 
Read RM csv Allows reading of a comma-separated value file from the microSD 

interface into the controller register space. 
Write RM csv Allows writing of a comma-separated value file to the microSD 

interface from the controller register space. 
Rename RM csv Allows renaming a file on the RM card. The data in the file is not 

changed. 
Delete RM csv Allows deleting a file on the RM card 
Copy RM csv Allows copying a file on the RM card. The data in the file is not 

changed. 
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12.6 Filenames used with the Removable Media (RM) Function Blocks 
 
The RM function blocks support the flash with a DOS/Windows standard FAT-16 file system. All 
names must be limited to the “8.3” format where the filename contains eight characters a 
period then a three-character extension. The entire filename including any path must be less 
than or equal to 147 characters. 
 
When creating filenames and directories it is sometimes desirable to include parts of the current 
date or time. There are six special symbols that can be entered into a filename that are replaced 
by the OCS with current time and date information. 
 
 

Table 12.1 – Filename Special Symbols  
Symbol Description Example 

$Y Substitutes the current 2 digit year 2004 = 04 
$M Substitutes the current month with a 2 digit code March = 03 
$D Substitutes the current day 22nd = 22 
$h Substitutes the current hour in 24 hour format 4 pm = 16 
$m Substitutes the current minute 45 = 45 
$s Substitutes the current second 34 = 34 

 
 
NOTE: All the symbols start with the dollar sign ($) character. Date symbols are in upper case, 
and time symbols are in lower case. The following are examples of the substituted time/date 
filenames: 
 
 
 

Current date and time = March 1, 2013 3:45:34 PM 
Filename: Data$M$D.csv  = Data0301.csv 
Filename: Year$Y\Month$M\aa$D_$h.csv = Year04\Month03\aa01_15.csv 
Filename: 
Month_$M\Day_$D\$h_$m_$s.csv 

= Month_03\Day_01\15_45_34.csv 
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12.7 System Registers used with RM  
 

%SR174 Removable 
Media Protect 

Write a 1 to %SR174 to prohibit read/write access to the 
removable media card. Write a zero (0) to allow access. 

%SR175 Status This shows the current status of the RM interface. 
%SR176 Free Space This 32-bit register shows the free space on the RM card in bytes. 
%SR178 Card 
Capacity 

This 32-bit register shows the total card capacity in kilobytes. 

 
Possible status values are shown in the table: 
 
 
 
 
 
 
 
 
 
 
 

 
 
For additional status information, consult the Cscape Help file. 

  

Table 12.1 – RM Status Values 
0 RM interface OK 
1 Card present but unknown format 
2 No card in slot 
3 Card present, but not supported 
4 Card swapped before operation was complete 
5 Unknown error 
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CHAPTER 13: FAIL-SAFE SYSTEM 
 

13.1 Overview 
 
The Fail-Safe System is a set of features that allow an application to continue running in the 
event of certain types of "soft" failures. These "soft" failures include: 
 

• Battery power loss 
• Battery-Backed Register RAM or Application flash corruption due to, for example, an 

excessive EMI event. 
 
The Fail-Safe System has the following capabilities: 
  

• Manually backup the current battery-backed RAM Register Settings into flash memory. 
• Manually restore Register Settings from the values previously backed up in flash 

memory to battery-backed RAM. 
• Detect corrupted Register Settings at power-up and then automatically restore 

them from flash. 
• Detect corrupted or empty application in flash memory at power-up and then 

automatically load the AUTOLOAD.PGM application file from Removable Media 
(Compact flash or microSD). 

• If an automatic Register Restore or Application Load occurs, the OCS can 
automatically be placed in RUN mode. 

 
 

13.2 Settings 
 
To use the Fail-Safe feature, the user needs to do the following: 
 

1. From Cscape, create AUTOLOAD.PGM for the application program using ‘Export to 
Removable Media’. 

2. Place the Removable Media with AUTOLOAD.PGM in the device. 
3. Set the ‘Enable AutoLoad’ option in the device to YES. 
4. Set the ‘Enable AutoRun’ option to YES if the controller needs to be placed in RUN mode 

automatically after automatic restore of data or AutoLoad operation. 
5. Backup the current battery-backed RAM Register contents in onboard flash memory. 
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13.3 Backup / Restore Data 
 
Backup OCS Data:  
 
 
When initiated, this will allow the user to manually copy battery-backed RAM contents on to the 
onboard flash memory of the OCS. This will have the effect of backing up all the registers and 
controller settings (Network ID, etc.) that would otherwise be lost due to a battery failure.  
%SR164.4 is set to 1 when backup operation is performed. 
 
 
Restore OCS Data:  
 
When initiated, this will allow the user to manually copy the backed-up data from the onboard 
flash to the battery-backed RAM.  
 
A restore operation will be automatically initiated if 1) a backup has been previously created 
and 2) on power-up the battery-backed RAM registers fail their check.   
 
The following process will be followed for restoring data: 

• The controller will be placed in IDLE mode. 
• Data will be copied from onboard flash memory to OCS battery-backed RAM 
• The controller will reset.  
• The controller will be put in RUN mode if the AutoRun setting is ‘Yes’, or else it will 

remain in IDLE mode. 
 

 
%SR164.3 is set to 1 when an automatic restore operation is performed. This bit is reset to the 
value of “0” when a new backup is created. 
 
Restoring of data can be manually performed by setting %SR164.14 to 1, this in turn sets 
%SR164.15 to 1. The user needs to set %SR164.15 to 0 complete the restore operation or set 
%SR164.14 to 0 to abort.  
 
 
Clear Backup Data:  
 
When initiated, the backup data will be erased from the onboard flash and no backup will exist.  
%SR164.4 and %SR164.3 is reset to 0 when backed up data is erased. 
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The OCS follows the following sequence in execution of Automatic Restore: 
 

 
 
 

Figure 13.1 – Flow Chart for Automatic Restore 
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13.4 AutoLoad 
 
This option allows the user to specify whether the OCS automatically loads the application 
AUTOLOAD.PGM located in Removable Media.   
 
When the AutoLoad setting is enabled (set to YES), it can be automatically initiated at power-
up. 
  
The automatic initiation will happen only in the following two cases: 
 

• When there is no application program in the OCS and a valid AUTOLOAD.PGM is available 
in the removable media of the device. 

• When the program residing in onboard memory is corrupted and a valid AUTOLOAD.PGM 
is available in the removable media of the device. 

 
 
When the AutoLoad setting is not enabled (set to NO), OCS will be in IDLE mode and the 
application is not loaded. 
 
%SR164.6 can be set to enable AutoLoad feature. 
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The OCS follows the following sequence in execution of AutoLoad: 
 

 
 
 

Figure 13.2 – Flow Chart for AutoLoad  
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13.5 AutoRun 
 
This option, when enabled (YES), allows the user to automatically place the OCS into RUN mode 
after the AutoLoad operation or automatic Restore Data operation.  
 
When the AutoRun setting is disabled (NO), the OCS remains in the IDLE mode after a Restore 
Data or AutoLoad operation. 
 
%SR164.5 can be set for putting the system into RUN mode automatically, once an AutoLoad 
has been performed or an Automatic Restore has occurred. 
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CHAPTER 14: MAINTENANCE 
 

14.1 Firmware Updates  
 
The RCC6512 products contain field updatable firmware to allow new features to be added to 
the product later. Firmware updates should only be performed when a new feature or correction 
is required. 
 
 
 
 
 
 
 
 
Steps for updating the firmware: 
 

1. Establish communication between Cscape and the controller using a direct serial 
connection to MJ1. 

2. Make sure your application is available on your PC or upload the application. 
3. Make sure the machinery connected to the RCC6512 is in a safe state for firmware 

update (see warning above). 
4. Start the firmware update by selecting File → Firmware Update Wizard. 
5. The correct product type should be selected, if it is not select the type of controller from 

the drop-down list. 
6. Wait for the firmware update to complete. 
7. If there is a communication failure check the cable, connections and comm. port setting 

and try again. 
8. Firmware updates typically delete the user applications to ensure compatibility. You will 

need to reload your application. 
9. Test the operation of the equipment with the new firmware before returning the 

RCC6512 system to an operation mode. 
 
 

LED Off ON Flash (1Hz) 
PWR No power 

applied 
10-28VDC 

applied 
 

OK  Self test fail Self test pass I/O forcing enabled. 
RUN Stop mode Run Mode Do I/O Mode. 

 
  

WARNING: Firmware updates should only be performed when the equipment being 
controlled by the RCC6512 is in a safe, non-operational state. Communication or hardware 
failures during the firmware update process can cause the controller to behave erratically 
resulting in injury or equipment damage. Make sure the functions of the equipment work 
properly after a firmware update before returning the device to an operational mode. 
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Load switch  
 

1. Pressing the LOAD switch during power-up boots from the microSD card. This starts a 
Firmware Load if the microSD is bootable and valid firmware files are found on it.  
 

2. After boot-up, pressing the LOAD switch for three (3) seconds will load an Application 
file stored on the microSD. The application file name must be DEFAULT.PGM. When 
loading an application file from microSD, there should not be firmware files present on 
the microSD card.  

 
NOTE:  When pressing the LOAD switch for three seconds after boot-up, if firmware files 
present on the microSD card, it can trigger a firmware update that may not properly 
complete.  

 
During the firmware update, the RUN and OK light will flash an alternating pattern. Once the 
firmware update is finished, load a program into the RCC and place in RUN mode. 
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14.2 Replacing Backup Battery  
 
The RCC6512 has a battery backup system that uses a lithium coin battery with a harness 
assembly which available from Horner Automation, part no. BAT00013. The battery backs the 
real time clock and retentive registers when power is removed.  
 
The battery will generally last seven (7) to ten (10) years. Environmental conditions, including 
extreme temperatures and humidity, can affect battery life.  If the battery is older than seven 
(7) to ten (10) years old, it is recommended that it be replaced as preventative maintenance. 
 
WARNING: DO NOT USE IF BATTERY IS LEAKING OR HAS BEEN DAMAGED.  
 
WARNING: LITHIUM BATTERIES MAY EXPLODE OR CATCH FIRE IF MISTREATED.  
DO NOT RECHARGE, DISASSEMBLE, HEAT ABOVE 100° C (212° F) INCINERATE, OR 
PUNCTURE. 
 
WARNING: EXPLOSION HAZARD – BATTERIES MUST BE ONLY BE CHANGED IN A AREA 
KNOWN TO BE NON-HAZARDOUS.  
 
WARNING: Disposal of lithium batteries must be done in accordance with federal, state, and 
local regulations. Be sure to consult with the appropriate regulatory agencies before 
disposing batteries. In addition, do not recharge, disassemble, heat or incinerate lithium 
batteries. 
 
WARNING:  Do not make substitutions for the battery. Be sure to only use the authorized part 
number to replace the battery. 
 
 
NOTE: The battery comes as an assembly with harness that includes a two-pin connector, and 
the complete assembly is field replaceable.  
 
Below are the steps to replace the battery: 
 

1. Disconnect all power from the RCC6512 and remove from the DIN rail.  
2. Remove all connectors, and then carefully use a flat head screwdriver to press and 

release the four clips.  Remove the back cover. 
3. The battery is connected to the I/O board by a two-pin connect. Carefully remove the 

battery and connector from the board. 
4. Dispose of the battery properly, see the above warnings on disposal regulations. 
5. Insert the two-pin connector of the new battery into the I/O board.   
6. Replace the back cover over the unit and gently press each corner evenly to snap the 

clips back into place.  
7. Apply power to the unit. If the battery is not functioning properly, remove the battery 

and contact Horner Technical Support.  
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CHAPTER 15: MODBUS COMMUNICATIONS 
 

15.1 Modbus Overview 
 
For complete Modbus instructions, please refer to the Help file in Cscape.  
 
Modbus (serial) and Modbus TCP/Modbus UDP (Ethernet) are popular, de-facto standard 
protocols that allow industrial devices from multiple manufacturers to easily share data in 
real-time. For Modbus serial communications, the RCC can act as a Slave. For Modbus 
Ethernet communications, the RCC can act as a Server (Slave) for Ethernet. 
 
Modbus protocol (serial or Ethernet) allows for multiple slaves. The master always initiates 
the conversation by sending a request to a particular slave. Only the addressed slave will send 
a response when the request is completed. Should the slave be unable to complete the 
request, it returns the appropriate error response. Should the slave be unable to respond, the 
master’s timeout timer expires to provide an indication of No Response.  
 

15.2 Modbus Slave Overview 
 
For complete Modbus Slave instructions, please refer to the Help file in Cscape.  
 
The Modbus function block, when used with the appropriate Modem and /or Open function 
blocks, allows the primary serial port on the controller to act as a Modbus/RTU slave. The 
Modbus function supports both ASCII and RTU modes of operation across a range of baud 
rates and protocol frames.  Also supported is port activity status, an inactivity timer, support 
for call-on exception, and support for store and forward (repeater) operation for radio 
modems.  
 
For Modbus Server (slave) over Ethernet, the Modbus/TCP protocol simply needs to be 
selected in the LAN1 section of the Hardware Configuration dialog box in Cscape - see Section 
11.3.2. The RCC will automatically reply to Read and Write requests from a Modbus TCP Client 
(master).   
 
Section 14.4 describes the supported Modbus Commands as well as the Modbus Map for RCC 
References. This map applies for both Modbus serial and Modbus over Ethernet. 
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15.3 Modbus Addressing Table for RCC Units 
To access RCC registers, a Modbus Master must be configured with the appropriate register 
type and offset. This is usually accomplished with one of two methods: 
 
1. The first method uses Traditional Modbus References, in which the high digit represents the 
register type and the lower digits represent the register offset (starting with Register 1 for 
each type). Since only four register types can be represented in this manner, RCC Modbus 
Function Blocks pack several RCC register types into each Modbus register type. Starting 
addresses of each RCC register type are shown in the Traditional Modbus Reference column 
of the Table 15.1.   
 
2. The second method requires the Modbus Master to be configured with a specific Modbus 
Command  and Modbus Offset. The supported Modbus commands and the associated offsets 
are also illustrated in Table 15.1.  
 

Table 15.1 – Modbus Master Mapping 

RCC 
Reference 

Maximum 
Range 

Traditional 
Modbus 

Reference 
(5 Digits) 

Expanded 
Modbus 

Ref.  
(6 Digits) 

Modbus Commands Modbus 
Offset 

%I1 2048 10001 010001  
Read Input Status (2)  

0 
%IG1 64 13001 013001 3000 
%S1 13 14001 014001 4000 
%K1 0 15001 015001 5000 

 
%Q1 2048 00001 000001  

Read Coil Status (1) 
Force Coil (5) 
Force Multiple Coils (15) 

0 
%M1 2048 03001 003001 3000 
%T1 2048 06001 006001 6000 

%QG1 64 09001 009001 9000 
 

%AI1 512 30001 030001  
Read Input Register (4) 

0 
%AIG1 32 33001 033001 3000 
%SR1 200 34001 034001 4000 

 
%AQ1 512 40001 040001  

Read Holding Register (3) 
Load Register (6) 
Load Multiple Registers (16) 

0 
%R1 2488 40513 040513 512 
%R1 2048 43001 043001 3000 

%AQG1 32 46001 046001 6000 
%R1 4096 -- 410001 10000 
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CHAPTER 16: TROUBLESHOOTING / TECHNICAL SUPPORT 
 
Chapter 16 provides commonly requested troubleshooting information and checklists for the 
following topics.   
 

- Connecting to the RCC6512 controller 
- Local controller and local I/O 
- CsCAN Network 
- Removable media 

 
If this information is not enough, please contact Technical Support at the locations indicated at 
the end of this chapter.    
 

16.1 LED - Normal Functionality   
 

Table 16.1 - LED: Normal Functionality 
LED Type When OFF When ON When Flashing (1Hz) When Toggling 

PWR No Power 
Applied 

10-28VDC 
applied 

N/A N/A 

OK Self-Test Fail Self-Test Pass I/O Forcing Enabled Application Loading 
from microSD RUN Stop Mode Run Mode Do I/O Mode 

LED State Description 
 
MS (Module 
Status) 

Green Module OK 
Red Real-Time Clock or I/O Configuration Error 

Red Flashing Illegal Ladder Instruction or Ladder CRC Error 
NS (CAN 
Network Status) 

Green Network OK 
Red Illegal ID, Duplicate ID, or No Response from Network Error 

 
 

16.2 LED Load Program/Firmware Functionality 
 

Table 16.2 – LED Load Program/ Firmware Functionality 
LED 

OK & RUN 
Flashing 

Alternately 
Flashing 
Together 

Flashing Stops 

Load program  
or firmware 

Download in 
Progress 

Download fails, 
number of flashes 
indicates the error. 

Download Complete, unit 
reboots (allow 30 seconds). 
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16.3 Switch - Normal Functionality 
 
Load switch  

- Used for program, as noted in previous section 
 

Run/Stop switch  
- After boot-up, pressing the RUN/STOP switch for three (3) seconds toggles the 

RCC between RUN and STOP modes. 
 
Switch – Erase Program Function 
Load and Run/Stop 

- After boot-up, pressing both Load and Run/Stop switches for three (3) seconds 
performs an “Erase All” function, which deletes all application programs. 

 

16.4 LED – Diagnostic Functionality 
 
The LEDs are also used to indicate some fault conditions in the unit. The two LEDs, OK and 
RUN, will flash a specific number of times depending upon the fault. There will be a two-
second gap and the pattern will be repeated. The number of flashes and the associated error 
are as follows: 
  
 

No. of flashes Table 16.3 – Diagnostic LED Flashing/ Fault Meaning  
2 The MAC ID is empty. 
3 The internal MAC file is corrupt. 
4 The MAC ID TXT file is invalid. 
5 The MAC ID file is not found or the USD card is empty or missing 

system files. 
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16.5 Connecting to the RCC6512 
 
Cscape connects to the local controller automatically when the serial connection is made.  The 
status bar below shows an example of a successful connection.  This status bar is located in the 
bottom right hand corner of the Cscape window.  
 
 
 
In general, the Target number should match the Local number.  The exception to this is when 
the controller is being used as a "pass through" unit where other controllers on a CsCAN 
network could be accessed through the local controller. 
 
Determine connection status by examining feedback next to Local & Target in the status bar 
of Cscape. 
 

Table 16.4 – Cscape Target & Local Numbers 

Local: ### If a number shows next to Local then communication is established to the local controller. 

Local: No Port 

Cscape is unable to access the COM port of the PC.  This could mean that Cscape is configured 
for a COM port that is not present or that another program has control of the COM port.  Only 
one Cscape window can access a port at a time.  Subsequent instances of Cscape opened will 
indicate No Port. 

Local: No Com Cscape has accessed a PC COM port, but is not communicating with the controller.  This 
typically occurs when the controller is not physically connected. 

Local: ??? Unknown communication error.  Close Cscape, power cycle the controller and reopen Cscape 
with a blank project.  Check Local. 

Target: #(I,R,D) If I (idle), R (run), or D (do I/O) shows next to Target number then communication is 
established to the target controller. 

Target: #(?) Communication is not established to the target controller.  Check node ID of controller and 
set Target to match.  Make sure local connection is established. 
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16.5.1 Connecting Troubleshooting Checklist (serial port – MJ1 Programming) 
1. Controller must be powered up. 
2. Ensure that the correct COM port is selected in Cscape. Tools →Applications Settings → 

Communications . 
3. Ensure that a cable with proper pinout is being used between PC and controller port MJ1. 
4. Check that a Loaded Protocol or ladder is not actively using MJ1.   
5. Successful communications with USB-to-serial adapters vary. If in doubt, Horner APG 

offers a USB to serial adapter. Part numbers HE-XCK and HE-CPK. 
 
16.5.2 Connecting Troubleshooting Checklist (USB Port - Mini B Programming) 

1. Controller must be powered up. 
2. Ensure that the correct COM port is selected in Cscape. Tools → Applications Settings 

→ Communications. 
3. Be sure that the USB cable is connected between the PC and the controller. Check 

Windows Device Manager to ensure that the USB driver is properly installed and to verity 
the port number.  
 

15.6.3 Connecting Troubleshooting Checklist (ETN port programming)                 
1. Controller must be powered up. 
2. Ensure that the correct IP address is given in the Ethernet field and correct Mode is 

selected, in Cscape: Tools → Application Settings →Communications . 
3. Ensure that an Ethernet connection has been established by pinging the controller 

from the Windows DOS prompt.   
 

 
 
 
 
  

WARNING: Setting outputs ON in Do I/O mode can result in injury or cause 
machinery to engage in an unsafe manner depending on the application and the 
environment.  
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16.6 CsCAN Network  
 
For complete information on setting up a CsCAN network, refer to CAN Networks manual 
(MAN0799) by visiting the Horner websites for the address to obtain documentation and 
updates. 
 
16.6.1 CsCAN Network Troubleshooting Checklist   

1. Use the proper Belden wire type or equivalent for the network as specified in 
MAN0799. 

2. The RCC6512 does not provide 24VDC to the network. An external voltage source must 
be used for other devices such as SmartStix I/O.   

3. Check voltage at both ends of the network to ensure that voltage meets specifications 
of attached devices. 

4. Proper termination is required. Use 121Ω (or 120Ω) resistors at each end of the 
network. The resistors should be placed across the CAN_HI and CAN_LO terminals.  
The RCC6512 has a software selectable terminator. 

5. Measure the resistance between CAN_HI and CAN_LO. If the network is properly wired 
and terminated, there should be around 60 Ω. 

6. Check for duplicate node ID’s. 
7. Keep proper wires together. One twisted pair is for V+ and V- and the other twisted 

pair is used for CAN_HI and CAN_LO. 
8. Make sure the baud rate is the same for all controllers on the network. 
9. Assure shields are connected at one end of each segment -- they are not continuous 

through the network.   
10. Do not exceed the maximum length determined by the baud rate and cable type. 
11. Total drop length for each drop should not exceed 6 m (20’). A drop may include more 

than one node. The drop length adds to the overall network length. 
12. Network should be wired in "straight line" fashion, not in a "star" pattern. 
13. In applications requiring multiple power supplies, make sure the V- of all supplies is 

connected and to earth ground at one place only. 
14. In some electrically noisy environments, it may be necessary to add repeaters to the 

network. Repeaters can be used to add additional nodes and/or distance to the 
network and protect the signal against noisy environments.   
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16.7 Removable Media - Basic Troubleshooting 
 

Table 16.5 – Removable Media Troubleshooting 

Description Action 

RCC6512 does not read media card. The media card should be formatted with the RCC6512. 

RCC6512 will not download project 
file. 

Make sure the project file is saved as a .pgm file and 
not a .csp file. In addition, to file must be .pgm, the 
file's I/O configuration must match the RCC6512 
configuration for it to download. 

 
 

16.8 Technical Support Contacts 
For manual updates and assistance, contact Technical Support at the following locations: 
 
North America:   
Tel:  (317) 916-4274 
Fax: (317) 639-4279 
Website: https://hornerautomation.com  
Email:  techsppt@heapg.com 
 
Europe:  
Tel: (+) 353-21-4321-266 
Fax: (+353)-21-4321826 
Website: https://www.hornerautomation.eu/ 
Email:  technical.support@horner-apg.com 
 
  

https://hornerautomation.com/
mailto:techsppt@heapg.com
https://www.hornerautomation.eu/
mailto:technical.support@horner-apg.com
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LED Normal Functionality, 95 
LIMITED WARRANTY, 3 
Maintenance, 89 
Manual Index, 11 
MECHANICAL INSTALLATION, 15 
microSD Cards, 78 

Installing / Removing, 78 
microSD System, 78 
Model / I/O Overview, 51 
Net Mask, 76 
Overview of the RCC6512, 10 
Panel Box 

Noise, 17 
Orientation, 17 
Temperature, 17 

Panel Box Shock and Vibration, 17 
Primary Power Port, 20 
Primary Power Port as Viewed Looking at the 

RCC6512, 20 
PROGRAMMING EXAMPLES, 3 
Pulse, 58 
pulse mode, 58 
pulse stream, 58 
Pulse Width Modulation, 56, 64 
PWM, 43, 46, 52, 56, 64, 65, 66 

Registers, 65 
Quadrature, 45, 57 
RCC6512 Dimensions, 16 
RCC6512 Manual PREFACE, 2 
register mapping, 51, 52 
Register Match, 59 
registers, 21 
Registers 

%S / %SR, 21 
Definitions, 21 
I/O, 30 
Resource Limits, 30 

Removable Media 
Load / Save Applications, 79 

Overview, 78 
Removable microSD Memory Card Slot, 78 
RM Status Values, 81 
RS-485 Termination, 69 
safety / compliance, 8 
Safety Warnings, Guidelines, 8 
Serial Comm 

Cscape Programming, 69 
Ladder-Controlled, 69 
Overview, 68 
Ports, 68 

SERIAL COMMUNICATIONS, 68 
Serial Port Pinouts, 68 
Solid-State Digital Outputs, 52 
sourcing, 52, 53 
stop state, 52 
Switch – Erase Program Function, 96 
Switch - Normal Functionality, 96 
System Registers used with RM, 81 
target ID, 38 
Target ID, 38 
target indicator, 38, 42 
Technical Support, 2, 95, 100 

Contacts, 100 
Testing for Good Ground, 19 
totalize, 57 
Totalize, 57 
Troubleshooting 

Common problems, 97 
Connecting Checklist, 98 
CsCAN Checklist, 99 
CsCAN Network, 99 
Removable Media, 100 

troubleshooting / technical support, 95 
Troubleshooting Checklist  (serial port – MJ1) 

Programming, 98 
Troubleshooting Checklist  (USB Port - Mini B) 

Programming, 98 
Troubleshooting Checklist (Ethernet port 

Programming), 98 
Two-Point Ground Connection Test, 19 
Types of Registers, 21 
Typical Output Wiring, 52 
USB, 32, 33, 72, 98 
Visual Overview of Types of Devices that can be 

connected to RCC6512, 12 
Where to Find Information, 11 
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Change Log 
 

Date Rev Description Location in Doc 
12/17/2021 9.1 Removed Expansion I/O information 

(7061) 
Removed from CAN 
Communications chapter.  

 


